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1 Introduction 

The Oasys Ltd LS-DYNA Environment 17.0 suite, dated March 2020, is a full release which 
supersedes all previous releases. 

This document lists the enhancements that have been made during development, and the bugs 
that have been fixed (since 16.1). Each ‘Case ID’ referred to in these lists is unique and should 
be cited if more information or clarification are required. 

 

1.1 Compatibility with LS-DYNA releases 

The 17.0 release has been used and tested with LS-DYNA version R11 and the development 
version of R12. It supports all the keywords in volumes I, II and III of the R11.0 User’s Manual 
dated October 2018. The majority of keywords in the development version of the manual for 
R12 are also supported. 

LS-DYNA R9.0 is the default keyword output format from PRIMER. (However, output may be 
generated for later releases of LS-DYNA.) 

 

1.2 Hardware platforms supported 

The complete Oasys Ltd LS-DYNA Environment 17.0 is available on the following platforms: 

Windows  Windows 10 

Note that support for Windows 7 has been deprecated as 
Microsoft is no longer supporting Windows 7. As far as we 
are aware, the software runs on Windows 7. 

64 bit 

Linux RedHat Enterprise 6.x, RedHat Enterprise 7.x, 
RedHat Enterprise 8.x 

SUSE Enterprise 12.2, SUSE Enterprise 12.3 

64 bit 

For simplicity of support and maintenance only the RedHat Enterprise 6.x build has been 
released on the website as this has been found to run on most machines. 

If you require a different Linux build, please contact Oasys Ltd. 

 

1.3 Graphics hardware supported 

The default graphics protocol used on all platforms in the table above is OpenGL, which gives 
good quality 3D performance on a wide range of hardware. 

‘Legacy’ X-Windows (2D only) graphics drivers remain in PRIMER on Linux platforms only, 
since these are used by a small minority of clients who display over a network of mixed machine 
types. However, this X driver is not maintained or updated and will give poor performance, so it 
should only be used as a last resort.  There are much better ‘thin wire’ graphics solutions 
available today, and Oasys Ltd can give advice about these on request. 
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1.4 Licensing 

Following a recent review of license management solutions, for Oasys 17.0 we have decided to 
switch from Flexera’s FlexNet Publisher (more commonly known as “FLEXlm”) to X-
Formation’s LM-X platform. 

Our review found LM-X to offer comparable functionality and features to other solutions 
available and provides an increased level of license security in networked scenarios often utilised 
on high-performance computing networks. 

LM-X is a well-known provider of licensing solutions and it is likely that many Oasys customers 
already have an LM-X license service running for other CAE tools. 

The Oasys Suite 17.0 software requires a new LM-X license file, which will be provided by 
Oasys Ltd or your Oasys distributor. If you are using a floating license server, you will need to 
install the LM-X license server software, which can be done as part of the Oasys Suite 17.0 
installation. 

The Oasys Suite 17.0 LM-X license file and LM-X license daemons are backwards compatible 
with both the 16.x and 15.x software releases. This means that any existing 16.x and 15.x 
software will continue to work with new LM-X license files and servers. 

We recommend that you update all your Oasys Suite license servers with the files shipped 
with the Oasys Suite 17.0 software. 

1.5 Important T/HIS JavaScript Update 

If you are upgrading from release 14.x, any JavaScript written for T/HIS 14.0 and 14.1 which 
used data components will not run in T/HIS 17.0. If you are already using T/HIS 15.0 or later 
then your T/HIS JavaScripts require no changes. 

 
This is because in T/HIS 14.x the data component constants were global constants.  They could 
over-write other variables used in the script.  From T/HIS 15.0 onwards, data components are 
accessed by a Component class. 

 
To correct your scripts which use data components make the following change to functions 
QueryDataPresent() and GetDataFlagged(): 

Release 14.x: 
m.QueryDataPresent(DX, Entity.NODE); 

curve_array = m.GetDataFlagged(f, DX); 

Release 15.x and later: 
m.QueryDataPresent(Component.DX, Entity.NODE); 

curve_array = m.GetDataFlagged(f, Component.DX); 

  



Oasys Ltd LS-DYNA Environment Software Release Notes 

Version 17.0 
 

Ove Arup and Partners Limited | Final | March 2020  

 

Page 3 
 

2 Bugs Fixed 

The enhancements and bug-fixes for each program have been broken down into a series of 
topics.  Within each topic enhancements and bug-fixes are listed by case ID. 

2.1 PRIMER 

2.1.1 Bugs Fixed in 17.0 

Adhesive 

• Case 41887 

The (re)make of connection adhesive on the table (or from xml file) on a large model can be very 
slow. Improving the efficiency of the logic has reduced a time of 540s to 55s for an in house 
model with about 600 adhesive connections. 

• Case 41871 

When making adhesive connections, any solids that exceed the warpage criterion are deleted. 
Unfortunately, when making from reading a connection xml file, the call to the deletion process 
can prevent some connections from being made. These will appear on the connection table where 
they can be remade. This has been fixed. 

Airbag 

• Case 41890 

IN *AIRBAG_PARTICLE when PFRIC less than -1.0, |PFRIC| is a curve of friction factor 
(unitless) vs. part pressure (if NDATA is greater than 0). 

The bug was about the PFRIC curve editor in PRIMER showing the x-axis as 'Scalar, no units' 
instead of 'Pressure'. 

This has been fixed. 

Ale or Euler 

• Case 41914 

*DEFINE_ALEBAG_INFLATOR will no longer show invalid index error (due to undefined 
dyna version) during text edit of the keyword. 

• Case 40290 

Bugfix for *ALE_STRUCTURED_MESH. The *ALE_STRUCTURED_MESH keyword header 
will now be written for every *ALE_STRUCTURED_MESH keyword. 

• Case 40240 

Added support for shell element in MAT_008. Now model check will not show incompatibility 
between MAT_008 and shell element. 
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Animation 

• Case 42778 

The (initial) setup portion of PRIMER's boundary prescribed motion animation function was 
previously taking an inordinate amount of time for certain implicit models. PRIMER also was 
not permitting users to click STOP and abort the process at that point. 

The timestep computed by the animation function was, previously, based on 'explicit' 
parameters. This would, when coupled with large end times, return an erroneous low value 
leading to large setup times.  

This calculation has now been modified to also look for 'implicit' parameters such as DT0 from 
*CONTROL_IMPLICIT_GENERAL. This should reduce the setup time significantly. User halts 
(STOP press) are now also processed in additional locations which should make it easier for 
users to abort this process. 

Attached 

• Case 42173 

The Save Current and Restore Saved options on Find attached panel have been corrected to reset 
the entity visibility as well as the blanking status. 

Belts 

• Case 41545 

The rules for EDGSET on *SECTION_SHELL, required for 2d seatbelt elements, have been 
tightened since LS-DYNA R8. In particular if a stretch of belt has a retractor then EDGSET must 
be located at the retractor mouth, and not at the topological end of the belt if the retractor has 
'coiled up' elements inside it waiting to emerge. 

The checks of *SECTION have been modified and extended to include these tighter rules. Also, 
the previous check that the set was not at the topological end of coiled up elements inside a 
retractor, now known to be incorrect, has been corrected. 

• Case 40574 

Removed the *SECTION error check for <edgset> nodes to be 'at the free end of the BELT'. 

Case 

• Case 40253 

PRIMER crashed while trying to edit keywords related to *CASE. Fixed this problem. 

Checking 

• Case 42735 

In the old xml file INI+16 used to be 2 lines. Now the d3msg file and therefore the new xml file 
indicates it has 15 lines. So, the code loops over what it thinks are 15 lines of the error message, 
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but in this old file there are not, so it accidentally reads all the following error messages as part 
of INI+16. Which has the effect that INI+313, 128 and 131 do not appear in the error tree. 

The bug has been fixed. 

• Case 42684 

Errors type fort.* added to the Dyna Output Reader 

• Case 42646 

Detailed checking of DATABASE types off the 'Explain' drop-down on the error check could list 
error messages for items that are not actually selected. Now fixed. 

• Case 42418 

PRIMER would crash if a custom JavaScript check created a non-modal GUI and the main check 
window was dismissed while this GUI was still running. Now fixed. 

• Case 40752 

RECHECK will recheck element qualities only when entered through Elem Qual but will not 
just recheck element qualities otherwise. 

• Case 40391 

*CONTROL_MPP_DECOMPOSITION_CONTACT_DISTRIBUTE will not show 'ID is not 
specified' for ID1-ID5 fields unless there is absolutely no ID defined (aka. all IDx fields are not 
specified). 

• Case 40030 

Fixed the duplicate Checking Error tags in various Keywords. 

• Case 39811 

PRIMER incorrectly reported non-structural node error when a massed node was secured only 
by a tied contact. This is fixed. 

• Case 37693 

The check for duplicate time history items did not work for complex sets, such as _GENERAL 
or _GENERATE. This has now been fixed. 

• Case 34424 

Element quality only checks can now be done from command line using QUAL_ON and 
QUAL_OFF options. 

Clipboard 

• Case 40071 

If the source model contains *PARAMETER_DUPLICATION in master file when parameters 
are copied to the target model (selected directly or by implication) in the find referenced phase, a 
matching *PARAMETER_DUPLICATION will now be written to the target file. 
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Coating 

• Case 42967 

When a segment set panel is created from the drop-down on the Coat elements tool, the 'Coat 
element' switch on that panel is now disabled. Also, the set panel is tidied when the parent Coat 
panel is tidied. 

Compare 

• Case 42786 

PRIMER would give an error message when switching between curves in the curve compare 
panel if the curves are in multiple models with a different number of include files. This has been 
corrected. 

Composites 

• Case 40148 

Automake function does not respect the preference 'create_composite_long'. Fixed that. 

Connections 

• Case 43098 

The connection contact maker was putting incorrect parts into the contact slave side when used 
to delete a contact which contains connection and non-connections. The option delete & remake 
will now leave a contact with its non-connection items. 

• Case 42740 

When connection layers are defined by part-set or other collector, the deletion of a single part 
could flag up the contents of remote connections for deletion, if the layers of these were defined 
by collector that included the part.  

As direct attachment to part is only known for a subset of connections (those that are made and 
in vicinity of parts to be deleted), we retain the layer lookup test. In this context, however, we 
count only direct reference to part and ignore all collector references (set, assembly, group). 

• Case 42612 

When remaking adhesive connections, some nodes may be reused for the new solids and 
possibly change position. If a node was owned by a morph box (MORB1) it could then move 
into a different morph box (MORB2) after remaking a connection. Previously, this node would 
still belong to MORB1 and hence would be unaffected by any morphing operations on either 
box. Now, PRIMER will reallocate this node to the appropriate morph box the next time a 
morphing operation is performed (provided morphing connections is turned on). 

• Case 42521 

The weld nodes in set/replace constrained toggle button on the connection create panel has been 
replaced with a radio button. The default is now 'weld nodes in set'. 
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• Case 41901 

Making of multiple bolt connections in a large model with complex sets is slowed by un-
necessary recalculations of set caches after each bolt creation. This has been fixed by deferring 
the operation. 

• Case 41898 

Filtering connection object menu by subtype could result in crash. Now fixed. 

• Case 41896 

Increasing max thickness option on the connection table that comes up with failed connections 
after xml read was causing a crash. This is fixed. 

• Case 41884 

When you create welds or adhesive by screen pick on panels modelled by a single layer of 
solids, the weld was starting at the picked visible face of the solid (the back of the panel). It now 
starts at the opposing face (the front of the panel). 

• Case 41880 

If a model is corrupted in such a way that >1 connections reference the same FE entity, it was 
impossible to empty and remake the connection as the external reference prevented deletion. The 
routine has been improved so that all the connections involved are emptied if this problem 
occurs. 

• Case 41718 

While connection compare is active, matched connections in the main model may suffer a 
temporary label change. The correct i.e. original label is displayed on the table and by sketch and 
on the object menu. 

When the compare panel is dismissed, the correct label is restored. 

• Case 40603 

The “by attached panels” method for selecting connections did not work well for HAZ welds. 
Now fixed. 

• Case 39979 

Object menu in Connection → create → select candidate → assembly method will now be 
unmapped when user clicks on Create button to prevent it from obscuring the radio buttons. 
Also, 'part set' and 'PRIMER assembly' buttons are shifted to different place in panel to make 
space for object menu 

Contacts 

• Case 43112 

*CONTACT_AUTOMATIC_SINGLE_SURFACE may thin the contact thickness on shells. 
This behaviour is correctly inhibited in Primer if SST is defined on the contact or 
*PART_CONTACT is defined. However, if SFST is defined on the contact, shell thinning 
should still be allowed. Modifications made to ensure PRIMER now works as expected. 
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• Case 42303 

The ONLY function for *CONTACT when applied to a contact with sstyp=4 (nodes on slave 
side) unblanks the elements that attach to these nodes using cross-references.  

If the node in <ssid> is the third node of a beam, we were incorrectly unblanking the beam. This 
is now trapped. 

• Case 42242 

The _ORTHO_FRICTION suffix for *CONTACT could be turned on from the edit panel for all 
types of contacts even though it is not accepted by DYNA. Now _ORTHO_FRICTION suffix 
can only be turned on for appropriate types of CONTACT. 

• Case 42149 

contact → modify → pencheck → options has been modified to map the contact → pencheck → 
options panel. 

• Case 32946 

Added sub-panel for editing the fields of _ORTHO_FRICTION suffix in *CONTACT edit panel 
in PRIMER. 

Contour 

• Case 41157 

Shortcut key for SI or CT display did not behave exactly like pressing the SI or CT button when 
changing between contour and vector display of shell normals. Fixed this problem. 

• Case 40376 

Modified the calculation of maximum and minimum limits of individual contour bands when 
discrete contouring is implemented. Band limits are now more precise, reducing possibility of 
values lying outside all bands. 

• Case 40125 

PRIMER will no longer crash if user clicks on 'Listings' after clicking on 'Shell Thk' or any other 
option in the Contouring menu (except Timestep and Mass scale). 

• Case 37994 

In CT/SI viewing mode in PRIMER, when the user clicks on one of the contour bands and hover 
the cursor over another band and proceed to resize the PRIMER window, the selection of the 
band will be changed. This problem is fixed now. 

Control 

• Case 42526 

Text on the popup of <NSOLVER> field in *CONTROL_IMPLICIT_SOLVER editor was 
incorrect. Corrected this popup text. 
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• Case 42492 

For the keyword *CONTROL_IMPLICIT_DYNAMICS, LS-DYNA defaults were not set 
correctly by PRIMER when the 'Set... LS-DYNA defaults' button was used. This has now been 
fixed. 

• Case 41798 

Previous versions of PRIMER would incorrectly suppress keyout of ICRQ on 
*CONTROL_SHELL if its value were non-zero but all other fields on the same row had a zero 
value. This has now been fixed. 

• Case 40088 

Values in greyed out textboxes on the *CONTROL_CHECK_SHELL panel are now cleared 
when rows are deleted. 

Cut section 

• Case 42707 

PRIMER can calculate the properties (Area, Ixx, Iyy etc.) of a cut-section, and this was failing to 
include all elements in the section when: 

- The cut plane was exactly on a line of nodes 

- The mesh was rectilinear 

- The origin of the cut plane was distant from the model (0,0,0) origin, and the element size was 
small. 

This was due to ill-conditioning. When a cut is exactly on a line of mesh it is important that the 
cut section calculations make an unambiguous choice between the two candidate elements on 
either side of a mesh line, cutting only one of them, otherwise elements could be double-counted 
giving the wrong answer. To do this the plane is shifted very slightly in its local outward normal 
(+Z) direction to take it off the exact mesh line and 'into' one of the elements, thus implicitly 'out 
of' the opposing candidate element. 

This shift must be small, and it was based on 1e-6 times the average side length of the element. 
However, when the element was small and the plane origin coordinate was large, i.e. distant 
from (0,0,0) in model space, this shift distance could get lost in numerical noise with the result 
that the cut remained ambiguous. In this situation PRIMER would not use either candidate 
element at all, resulting in a hole in the cut-section. 

The existing logic which tried to avoid this 'lost in numerical noise' problem was inadequate, so 
it has been recoded to make it more robust and the problem should not recur. 

Database 

• Case 40292 

PRIMER will no longer crash if user clicks SET DEFAULTS in DATABASE → Create → 
FREQUENCY_BINARY_D3ACC. 
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Deleting 

• Case 42109 

Deletion of *AIRBAG_SHELL_REFERENCE_GEOMETRY could be un-necessarily slow. An 
N-squared loop has been removed. 

• Case 42029 

In a model containing *CASE, problems could arise if REMOVE was performed and the 
(default) setting to save the removed items for 'undo' was selected. 

In addition, 'undo' might not work correctly if the items to be undone contained 
*SET_COLLECT definitions. 

Both problems arose from the way the temporary undo file was written and subsequently reread 
and have been fixed. 

• Case 39807 

The 'Undo' button is now enabled when deleting morph box from Morph → Utilities.  

Dummies 

• Case 40859 

Global damping and individual damping are now calculated separately with different factors. 

Edit 

• Case 41916 

Sketch off generic edit panel where one or more entries is zero could lead to a crash. The initial 
sketch works, but any attempt to rotate the model and do a redraw sketch will crash. This has 
been fixed. 

• Case 41329 

In the Keyword Editor it is possible to filter what is displayed to a subset of possible types of 
each keyword suffix. For example, you might limit what is shown in the *CONTACT keyword 
editor to only the _AUTOMATIC_GENERAL contact type to avoid seeing contacts that are not 
currently of interest. 

Changing any active suffix of any entity (for instance in this example you might change the 
_OFFSET suffix of some contact to _CONSTRAINED_OFFSET) had the effect of resetting the 
'what is displayed' filter for all suffices, effectively cancelling the filter you had set up 
previously. This had the result of making all the unwanted rows you had carefully filtered out 
suddenly becoming visible again. 

This has now been fixed: changing the active suffix of any entity will not reset the 'what is 
shown' filters, subject to one exception.  

The exception is that if you have previously turned off display of a given suffix, but you then set 
this suffix for an entity, then visibility of that suffix will be turned back on. If this is not done the 
row of the entity you have just changed would disappear from the editor! 
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• Case 41264 

Line longer than 80 characters in *DEFINE_CURVE_FUNCTION is written out in separate 
multiple lines while keying out. A space is added at the start of the line if the new line starts with 
'*'. 

Explode 

• Case 42080 

Previous versions of PRIMER were found to crash in the Explode menu with a specific model 
under hard-to-reproduce conditions. The issue stemmed, partly, from an attempt to manipulate 
nodes containing no cross-references and has now been fixed. 

FMH 

• Case 41903 

Shortened the display width of floating numbers for head to target position in the IHI FMH tool 
to fit textboxes. 

Frequency 

• Case 40814 

On the card with NID, NTYP, IPFILE, PRIMER was incorrectly treating NID as an individual 
node if NTYP=1. (NTYP=1 is supposed to be the SET option). This means if edited 'NID' we 
would get a node panel instead of the node set panel. This has been fixed. 

Geometry 

• Case 41877 

PRIMER could crash when undoing deletion of geometry surfaces. Now fixed. 

• Case 41706 

An error which caused importing an IGES file to fail has been fixed. 

Graphics 

• Case 42656 

Previously, some 3D symbols could disappear when viewed in certain orientations. This has now 
been fixed. 

• Case 42516 

Corrected repeated N1C field names in card 3 of *INCLUDE_STAMPED to N2C and N3C. 
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• Case 41878 

Previously, when dynamically rotating a large model, whilst in the morphing panel, PRIMER 
could register an undesired morphing operation before then rotating the model. A similar issue 
was also present in Contact depenetration. This issue has now been fixed and the functionality of 
mouse drag events updated. Now, in the context of morphing, doing the following: 

1. Clicking and dragging a morph point. 

2. While still holding the mouse button, pressing and holding shift and dragging the mouse. 

3. While still holding the mouse button, releasing shift and dragging the mouse. 

will: 

1. Morph the model. 

2. Stop morphing and dynamically rotate the model. 

3. Stop rotating the model and begin morphing again. 

• Case 41623 

A new 'Go Back' button has been put inside Graticule sub-panel. Pressing 'Apply' now inside the 
Graticule sub-panel would update the graphics but not take the user outside the sub-panel. 

• Case 41605 

The diameter of true section for truss type beams (elform=3) has been corrected. 

• Case 40761 

A preference is added to hide the outline [drawn by the cross-section when it cuts through the 
part] of the part. Turning off the visualization of the outline reduces the time taken by PRIMER 
to load/show multiple entities. The preference will make a difference if the model is too big and 
has hundreds of cross-sections. 

• Case 39952 

Previously, selecting drag handles in a large model would be very slow (as well as navigating the 
morph panel). This speed of these processes has been improved. The ability to select drag 
handles by area (when in selection mode) has also been added. 

Groups 

• Case 41104 

The entities inside a GROUP which is locked against clean-up also gets listed for clean-up. The 
same behaviour was shown by SETs that are locked against deletion. Fixed these problems. 

Help 

• Case 41855 

Clicking on the manual button in PRIMER (and D3PLOT, T/HIS, REPORTER and the SHELL) 
was not using the default browser. It always opened in Internet Explorer. This has been fixed. 
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Include transform 

• Case 42016 

*INCLUDE_TRANSFORM options PREFIX and SUFFIX are now supported in the display of 
part, material, section, define_curve names in PRIMER. The extended part name is also written 
to the ztf file for export to D3PLOT. 

IGA 

• Case 42263 

PRIMER would not read in models with NPLANE > 4 on the 
*INITIAL_STRESS_SHELL_NURBS_PATCH card. This restriction has now been lifted and 
NPLANE can by any positive value. 

• Case 42223 

A model with IGA data (*ELEMENT_SHELL_NURBS_PATCH) failed to read into PRIMER 
with the error message 'Stuck in loop while splitting trias at index xx/yyyy for surface z'. 

This has been fixed and a preference has also been added (PRIMER*geometry_max_trim_split) 
that sets the maximum number of trias that can be split by a trim curve segment before PRIMER 
will abort reading the surface. 

Integration 

• Case 41606 

Entity panels in D3PLOT and PRIMER were not synced properly for 
CONSTRAINED_SPOTWELD and GENERALIZED_SPOTWELD entities. Fixed this 
problem. 

JavaScript API 

• Case 42886 

Arguments for methods that are integers are now checked more thoroughly. A warning is given 
if the number is not an integer and the number will be rounded to the nearest integer. 

Arguments for methods that are numbers are now checked for validity. If the value is NaN (Not 
a Number) then an exception is now thrown. 

• Case 42773 

The KeywordCards and toString methods for some keywords that had titles did not work 
correctly and the title could be omitted. Now fixed. 

• Case 42771 

The property '2dbinr' on contact cards could not be modified or referenced through the 
JavaScript API. This is because properties cannot start with a number. This property has been 
renamed 'dbinr'. 
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• Case 42756 

When something was typed into the textbox to print a variable the Print button did not 
immediately become active. Now fixed. 

• Case 42652 

Now you should be able to set the 'thick' parameter in *CONSTRAINED_SPR2. This has been 
fixed. 

• Case 42588 

Model.Import() would not respect the current layer set in PRIMER. This has been corrected. 

• Case 42454 

The onClick event would not always work correctly in JavaScript if a button was defined inside 
another button. 

This was because buttons are drawn in the order [first defined] ... [last defined] meaning that the 
last drawn of two coincident or overlapping buttons will be what you see on the screen. 
However, the internal determination of where a mouse click occurred was also performed in the 
same order meaning that it would find the first of two overlapping buttons, which is not visually 
correct. 

Fixed by making the loop that decides which button the mouse is over search from [last defined] 
backwards to [first defined] which solves this problem. 

• Case 42432 

Setting the parm1, parm2, parm3, parm4 and parm5 properties for the Beam class did not work. 
Now fixed. 

• Case 42293 

Previously if, in a JavaScript, an onClick function was used to delete all widgets contained 
within a window PRIMER could crash. This has now been fixed. 

• Case 42244 

It is now possible to use include files for scripts that are encrypted. 

• Case 42202 

A few fields from CONTROL_OUTPUT have been added to the JS-API. 

• Case 41511 

Using non-existent initial directory in Window.GetDirectory on Windows caused a different file 
selector to be used which did not have all the features you would expect. If the initial directory 
does not exist, we now ignore it. 

• Case 41252 

Modified JavaScript API Sensor constructor: added optional nid and nid2 parameters. 
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• Case 40853 

When using the JavaScript ImportInclude() method to import and include file into an existing 
model error could arise if the include file referenced *PARAMETER definitions that were 
present in the target model, generating errors about parameters being referenced but not defined. 

The reason for this is that the ImportInclude method reads the include file into a separate 
(scratch) model, then merges this into the destination model. That scratch model is initially 
empty, so the parameters are not present within it, hence the errors.  

So, PRIMER now temporarily copies all *PARAMETER cards in the target model into this 
scratch model before reading the include, meaning that they can be successfully resolved. The 
parameters are then removed again prior to the model merge operation so that they do not 
generate clashes. 

• Case 40061 

The property LCINT for CURVE has been added to the JS API documentation. LCINT can now 
be passed as an argument to the constructor function. 

• Case 40052 

Fixed broken links in PRIMER JS API manual. 

Keyword 

• Case 42896 

The PFAC card on ALE_STRUCTURED_FSI can be zero, but this was not allowed in the edit 
panel. This has been corrected. 

• Case 42889 

In *ALE_STRUCTURED_MESH, field <CPIDX> can now be 0 or -1. 

• Case 42465 

Optional cards in *CONTROL_THERMAL_SOLVER are now greyed and ungreyed according 
the SOLVER value.  

• Case 42360 

If a *PART is referred by an *EM keyword, there should be a *EM_MAT keyword with the 
same label as <MID> field of the *PART. PRIMER now checks whether appropriate 
*EM_MAT keyword exists while doing model check. 

• Case 42265 

PRIMER now allows ELFORM=3 for *ELEMENT_SHELL_NURBS_PATCH 

• Case 42264 

PRIMER now allows ELFORM=201 for *SECTION_SOLID. 

• Case 42079 

Now if PSID is less than 0 in *CONTROL_CHECK_SHELL then it takes it as set part. 
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• Case 41931 

You could add multiple instances of *ICFD_DATABASE_POINTAVG and 
*ICFD_DATABASE_NODEAVG cards in PRIMER even though LS-DYNA expects only one 
instances of them in a model. Now PRIMER shows a warning when a user creates more than one 
of these keywords. 

• Case 41611 

Included MAT keywords which lacked a warning for aopt=1 under a common check. 

• Case 41165 

Parameters were not being handled correctly for the last four fields in the first row of 
*ALE_STRUCTURED_MESH_TRIM. This issue has now been fixed. 

• Case 41164 

Changed *ALE_STRUCTURED_MESH_MOTION and *ALE_STRUCTURED_MESH_TRIM 
from labelled to unlabelled (ALEX). 

• Case 41048 

Modified check message for *CONTACT_ENTITY: field G3 can now accept -1 for GEOTYPE 
11. 

• Case 40847 

A title will now not be keyout for *DEFINE_HEX_SPOT_ASSEMBLY, as it is invalid. 

• Case 40762 

In *INTERFACE_COMPONENT_NODE keyword CID and NID are now optional as specified 
in the manual. 

• Case 40632 

CONTROL_IMPLICIT_SOLUTION, for NSOLVR value: had to remove default from option 2 
and add it to option 12. 

• Case 40601 

Corrected the error message related to the field <NSDX> in keyword 
*CONSTRAINED_JOINT_STIFFNESS. 

• Case 40212 

PRIMER will now write NUM field as 'int' instead of 'float' for MAT 154. 

• Case 40120 

Create/Modify keyword panel could not take -1 value for the field <PID> in keyword 
*INITIAL_DETONATION. Fixed this problem. 
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• Case 40022 

Keyword creation panel was throwing an error when -1 is entered in the PID field of the 
keyword *INITIAL_DETONATION. Fixed this problem. 

• Case 35249 

PRIMER considered <GMSET> field in *INTERFACE_SSI_AUX_EMBEDDED as a label 
reference to *INTERFACE_SSI, but this is incorrect. Fixed this issue. 

Keyword editor 

• Case 42285 

Value inserted in SETYP field in *CONTROL_EXPLICIT_THERMAL_INITIAL was copied 
into the SET field. This bug is fixed now. 

• Case 41163 

The DEFINE_MATERIAL_HISTORIES edit panel did not display correctly. This has been 
corrected. 

• Case 39998 

The keyword editor for *CONTACT has an extra 'pseudo keyword suffix' which is in fact the 
number of optional additional cards A-F to show for each contact. (Not showing these if they are 
not required makes the editor more compact and thus much easier to use.) 

There was an error which meant that if multiple editor rows were highlighted, and a change was 
made to an additional card in contact definition A then this change would not be propagated to 
highlighted contact B unless that too already had this additional card active.  

A similar error would occur if one of multiple highlighted rows was edited in the scalar editor 
(i.e. [right click, edit]) and additional rows were added. Changes to this definition would also not 
be propagated to other highlighted rows unless they already had the additional rows active. 

These errors have now been fixed. In effect changes to or creation of additional contact cards 
will be propagated correctly to other highlighted rows. 

Labels 

• Case 41864 

Post-end labels used in *INCLUDE_TRANSFORM were offset by some internally calculated 
amount, whereas users expect them to use IDROFF if that is set. The old behaviour led to 
unexpected error messages from the label range check about dummy labels, group labels, etc. 
Also, a model would not read if post-end item existed in main model and 
*INCLUDE_TRANSFORM (with correct offset) contained one at same label. 

Using IDROFF as the offset now solves both these problems. 
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Loading 

• Case 40866 

Added support for the M3 field to be negative for *LOAD_NODE to apply force in the direction 
from node M1 to M2 for versions ≥ R8.0 

Local axes 

• Case 42963 

PRIMER's local axes display function was previously not handling a combination of 
*PART_COMPOSITE and *ELEMENT_TSHELL_BETA correctly. This has now been fixed. 

Macro 

• Case 40851 

Macro tags were missing for some buttons in the Menu attributes panel. Added macro tags for 
these buttons. 

Manual 

• Case 42990 

If Microsoft Edge was the default program associated with opening .html files, the manual would 
not open from PRIMER (and D3PLOT and T/HIS). This has been fixed. 

• Case 38454 

If a web browser was already open on Linux and the user tried to open a manual page then the 
program would hang. The manual page should now correctly open on a new tab in the existing 
web browser session. 

Mass 

• Case 41203 

Assign mass checking sometimes reported failure to reach target mass and remaking the assign 
mass did not remove the error.  

This was found to be a discrepancy in the way off structure lumped mass is included. This is 
mass on NRBs or *CONSTRAINED_EXTRA_NODE which belongs to an assign mass part but 
is not actually on a structural element. This is now fixed. 

Mechanism 

• Case 41759 

Mechanism was not rotating in local coordinate system even when it was defined and not 
showing correct values in the panel after rotation was performed. This has been fixed now. 
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• Case 41634 

Previously, PRIMER would incorrectly issue a warning stating that an Assembly was empty if it 
contained latent Parts, or Part Sets that only contained latent Parts, even if these latent Parts 
contained structural entities. This has now been fixed. 

• Case 41608 

When positioning a mechanism in the 'Rotate angles' mode, entering an angle close enough to 
180 degrees (greater than about 170 degrees) as Z rotation kept the mechanism moving forever. 
This has now been fixed. 

• Case 41361 

On mechanism hinge and line connections stop angles were previously defined in the range 
between -180 and +180 degrees. Angles of ±180 degrees denoted unlimited rotation. 

These limits have now been removed, so it is possible to define stop angles greater than 180 
degrees in absolute value. In those cases, the numbers of rotations of connections are counted in 
the positioning to define when the stop angles apply. 

Menus 

• Case 40109 

Updated error message: CSYS limit changed from 9999 to 99999 in R7. 

• Case 39824 

Slightly modified how the quick find function searches for items so that it now does a more 
exhaustive search. 

• Case 39037 

Increased the bonus score given to matched sequential characters in quick find to give more 
intuitive results. Also made the bonus points for sequential characters and characters at the start 
of words configurable by the user on the quick find popup menu and via preferences. 

Merge 

• Case 41836 

Merging models containing *SET COLLECT sometimes did not work correctly and some sets 
could be omitted. Now fixed. 

• Case 40128 

Added an extra warning option while merging the models with label values larger than the LS-
DYNA standard format. 
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Mesh 

• Case 43117 

In geometry mesh, meshing surfaces a second time after 'Restart', output joined mesh had some 
crack. It has been fixed now. 

• Case 41910 

Fixed an issue with unit conversion in the geometry mesh join surfaces. 

• Case 41889 

Fixed the Swage creation on the non-planar surfaces. 

• Case 41208 

An option to provide user defined meshing parameters is added under 'Program' which has 
helped achieved a good quality mesh around spotwelds in the vehicle after HAZ spotwelds 
creation. 

• Case 38175 

Added ability to maintain part boundaries during remesh. 

Model build 

• Case 41657 

Use of model build in simple mode with component files that contain includes has been fixed to 
support relative path for component containing include_transform.  

Also, the orientation during build was failing to move the child include for such component files. 
Now fixed. 

Model modified 

• Case 41173 

The *INCLUDE tree’s 'compare include' function (an option on the per include dropdown menu) 
did not work correctly if the model has originally been read as a packed .zip file. That is a single 
main.zip file containing the master file, and all include files for the model. 

The reason was that the 'compare' function writes a scratch include file, and this was getting 
confused about compression and packing into the .zip format. Fixed by effectively turning off 
file compression temporarily during the comparison process. 

Morphing 

• Case 42765 

Previously, Morph Flow labels (MORF X) would be drawn in the same positions as the affected 
Morph Point labels (MORP Y), making them difficult to read. This has now been fixed. 
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• Case 41825 

Previously, in the morphing panel if the drag handle picking mode was set to 'Selection' and 
some drag handles were selected, flicking between the 'Create' and 'Morph' tabs would reset the 
picking mode to 'Interactive' and the handle selection would be reset. This has now been fixed - 
the handle picking mode and handle selection are maintained when switching between tabs in the 
morphing panel. 

Node 

• Case 41778 

The Node edit panel, when opened in 'Modify' mode would, previously, allow users to access the 
following modes that never really worked: 

- Create between 2 nodes 

- Create between 3 nodes 

- Create at the centre of a circle 

These modes were never designed to work in 'Modify' mode and are thus no longer accessible. 

These modes can still be accessed during node creation as always. 

Orient 

• Case 42585 

Previously, morph boxes, morph points, and morph flows could be selected to be oriented 
individually (separate a model orient). This has now been changed such that these entities can 
only be oriented as part of a model orient. 

• Case 42028 

Previously, if a morph box, morph point, or a model containing a morph box was oriented, the 
positions of the morph box's drag handles would be incorrect. This has now been fixed. 

Output 

• Case 42199 

PRIMER could give an error or crash when writing an ABAQUS file if the model did not 
contain any nodes or sections. This has now been fixed. 

• Case 42184 

PRIMER's binary file format (.kby file extension) contained a bug which meant that it could fail 
if a floating point data field contained the special value -0.0.  

This has been fixed by trapping the special -0.0 value when writing a binary file and replacing it 
with the conventional zero value 0.0 inside the file. This makes no numerical difference to the 
value as a computer treats 0.0 (implicitly positive) and -0.0 as identical values, it simply loses the 
distinction that 'this value of zero was arrived at due to negative underflow'. 
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• Case 41755 

Dyna output tree was not being updated after an entity was deleted externally to it. Now fixed. 

• Case 41028 

When 'large' format was introduced there was some uncertainty about its finer details, and the 
way long character strings were handled was not specified. Filenames longer than the 80 
character limit in small format can be written out by using continuation lines, but the way this is 
handled in large format was not specified. 

As originally programmed, PRIMER assumed that in large format the entire filename could be 
written on a single line, with no need for continuation lines. However, this turns out to be wrong, 
and that the correct syntax is to use the same continuation logic as small format, but with lines 
limited to 160 characters instead of 80. 

In practice, it is unusual for a pathname/filename combination to reach 160 characters in length, 
so as far as we are aware this has not affected any users. However, the syntax in PRIMER 17.0 
has been corrected so that path/filenames longer than 160 characters are now split over 
continuation lines in large format. 

Parameter 

• Case 42592 

Three related problems with character parameters: 

(1) When a character parameter was used to define the include filename in an *INCLUDE 
statement, this would sometimes fail because 'left over' characters from previous input lines 
could get concatenated with the filename when it was extracted from the parameter during input 
resulting in the filename becoming corrupted. 

(2) In the special case of *INCLUDE_TRANSFORM, a related problem could also cause the 
reading and transformation of the include file to fail. This was because of the way the character 
parameter was copied to the scratch model used internally for input of the untransformed 
include. 

(3) More generally, if a character parameter was defined and then referred to in the title of a 
keyword, then PRIMER would tend to turn that reference into the underlying parameter value. 
For example, the card sequence: 

*PARAMETER 

C MY_PARAM String 

*keyword_TITLE 

&MY_PARAM 

Would result in the output from PRIMER: 

*keyword_TITLE 

String 

All these problems have been fixed.  
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However, the use of character parameters remains problematical in PRIMER because they can 
be used in such a general way in so many different contexts, making it very difficult to avoid 
errors like the above. It is recommended that if they are used it should be in a very simple way. If 
you are not sure please contact Oasys Ltd for advice. 

• Case 42033 

When a parameter with name longer than 9 characters was written in small keyword format, 
PRIMER truncated the name without any warning. This could have corrupted references to that 
parameter or confused it with another one after reading the model again. Now, PRIMER shows 
the same overflow error as for other character data fields. 

• Case 42022 

When merging two models with small labels (fitting into data fields of width 10) and clashing 
parameter names, PRIMER sometimes renamed the parameters such that their names became 
longer than 9 characters. This then required large keyword format when writing the model or the 
names would have been silently truncated. This has now been fixed such that model merge only 
creates parameter names longer than 9 characters when the target model already needs to have 
large format for a different reason. 

• Case 41814 

LS-DYNA no longer accepts models where parameters are referred to (used) in a particular 
include but are defined in a 'subsequent' include. This scenario is now trapped and flagged by 
PRIMER. 

• Case 41161 

On the parameter edit panel, the filter string sometimes left a blank list of parameter definitions 
when it did not match any of the parameter names. Now, if it does not find any matches, it 
displays parameters where the string or pattern only matches the beginning of the name. 

For example, when abc is typed in, previously PRIMER would only have shown parameters with 
the exact name abc. Now it will show all parameters beginning with abc if there is no exact 
match for abc. If there is a parameter with exact name abc, not just beginning with abc, then only 
that will be shown as before unless the wildcard string abc* is provided in the text box. 

• Case 41151 

When reading a model with parameters referenced before they are defined and there was 
*INCLUDE_TRANSFORM definition following the definition of the parameters, the parameters 
appeared in their order of first reference inside PRIMER and were also written out in that order. 
Sometimes this caused errors by expressions appearing before parameters which they reference. 
Now the parameters appear correctly in the order of their definition in the same way as they have 
always appeared without *INCLUDE_TRANSFORM. 
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• Case 40935 

A *PARAMETER_EXPRESSION containing a function call with more than one argument, so 
with a comma in the argument list, could be misinterpreted as a field delimiter on a comma-
separated line. For example: 

*PARAMETER_EXPRESSION 

R VALUE min(&A, &B) 

Would misinterpret the comma as meaning that the parameter name was 'VALUE min(&A,' 
which caused an error during keyin. 

Paradoxically converting the line to comma-separated format, vis 

R VALUE, min(&A,&B) 

worked fine, because the first comma was (correctly) interpreted as a field delimiter. 

Fixed by improved interpretation of the line: a comma separating function arguments must be 
inside (...) brackets, so all that is necessary to distinguish the two cases is to look for a leading '(' 
character. 

• Case 40696 

PRIMER sometimes silently truncated parameter expression lines at 70 characters. This 
truncation may happen in LS-DYNA, but in some cases, it can evaluate to a different result. 
PRIMER now warns about such expressions offering the option to reformat them when reading a 
model in the same way as in the check tool. 

PRIMER 16.0 and older had already got a check for this, but it did not look at results of 
expressions evaluated with misread lines. 

• Case 40651 

When *PARAMETER_DUPLICATION is changed inside PRIMER, referencing keywords may 
point to other parameters of the same name, and PRIMER has got a message allowing to update 
the model with these new values. 

When changing the option from ‘Accept’ to ‘Ignore all references point’ have pointed to the first 
definition of duplicate parameters after the update. When changing from ‘Ignore’ to ‘Accept’, no 
references were changed, and there was no message about this. In general, PRIMER does not 
know which parameter of the same name a keyword should refer to, so it continues to keep the 
first one, but in PRIMER 17.0 there is now a message listing all potential ambiguities in 
references after that duplication change. 

• Case 40526 

PRIMER now supports the use of character parameters as filenames in *INCLUDE statements. 
When the required strings are longer than the value string length for a character parameter, it is 
also possible to use _EXPRESSION character parameters. 

When the value of such a parameter changes, this does not replace contents of a file, but rather it 
renames the include file in the same way as it can be done on the include tree. 

When the model is written and the *INCLUDE file lines become different, for example when 
directory names included in the parameter value string need to change from INCL to INCL_1, 
then the *INCLUDE statements are written without parameter. 
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• Case 40262 

PRIMER will sometimes fail to read an input deck when data fields are defined by parameters 
and those parameter definitions are not present, or perhaps present but only after the definition 
that refers to them, because at the time the card is read the correct parameter value is not known. 

PRIMER assigns the value zero to 'not known' parameters, then loops back later to reformat the 
card once the parameter value is known. This process works in most cases, but it can fail when 
the parameterised data field determines the layout and quantity of subsequent lines on the data 
card. Such errors usually result in PRIMER rejecting the input deck with a MISSING_DATA 
error and deleting the model. 

This approach has been criticised for being too severe - why not just skip the offending card and 
continue reading the deck? This approach has been reviewed, and the logic remains unchanged 
for the following reasons: 

(1) When there is a mismatch between what a data card expects and what it reads from disk 
PRIMER is in the situation of not knowing what it has read. Are the card's contents correct? 
Have we read - say - two cards when we should have read only one? 

In this situation it is very difficult to determine accurately what should be deleted and ignored. 

(2) As a corollary to the above there is a severe danger of earlier data cards being 'plausible but 
wrong'. In other words, lines before the offending one may have been read and misinterpreted, 
possibly with no obvious signs of error. 

(3) Finally, when PRIMER is run in batch it is easy for the normal errors and warnings that occur 
during keyword input to be missed, meaning that a model may appear to be OK when in fact it is 
not. 

For all these reasons it is safer to adopt the strict approach of treating this as a severe error, 
terminating keyword input and deleting the model, so this behaviour remains. 

However there *are* options which allow problematic input decks to be read into PRIMER, 
although doing so may introduce errors so these are not the default. These are not well known so 
an extra explanation has been added to the severe error termination message which details how 
to use these and gives suggestions and suitable warnings. 

• Case 40027 

It is illegal for a parameter expression to reference itself, but when there are duplicate parameter 
definitions, it appeared to be possible that a parameter expression references its own name, but 
this was referring to another parameter definition of the same name. This can be legal in LS-
DYNA by using the _MUTABLE suffix or certain *PARAMETER_DUPLICATION options of 
2 or 4. 

PRIMER did not evaluate parameter expressions in those cases correctly. Now it uses the most 
recent value of a parameter with the same name to evaluate the expression. 

• Case 39994 

When writing a character parameter with value string longer than 10 characters in small format, 
the value was truncated in PRIMER. The warning message was sometimes not easy to see in the 
log. 

PRIMER has now got a new output option such that the model writing is aborted when character 
data is longer than the field width. 
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Furthermore, the Check tool in PRIMER now picks up overflow in character data fields, which 
may otherwise be truncated. 

• Case 39888 

When the top level parameter panel is open and a parameter is edited from the hover popup of 
another edit panel, for example from a node edit panel, then resetting parameters on the top level 
panel did not work correctly. Now, updating the parameter from the popup updates the model 
with the new value and refreshes the top level parameter panel. Reset on the top level panel only 
brings you back to the parameter value just updated from the popup in that case. 

• Case 37025 

When a parameter expression fails to evaluate (for example with an unknown variable), then it 
gets the value 1 internally in PRIMER. When another expression references the expression with 
unknown value, then it did not get an evaluation error as well but was using 1 for the unknown 
value. For example, suppose we have got an expression b defined as 10*a, where a is undefined, 
and c defined as 10*b, then b continues to have evaluation errors with internal value 1, but c now 
gets evaluation errors as well in PRIMER instead of the silent evaluation of 10*b=10*1=10. 

Part tree 

• Case 41526 

Include keywords are read in part tree. 'keyword' option is now greyed out for Include header in 
part tree. 

Pedestrian 

• Case 41326 

The default height is now set to 25 mm from 75 mm for GTR protocol. 

Penetrations 

• Case 43063 

The contact crossed edge fixing function was eliminating all crossed edges as soon as the first fix 
was made, meaning the user had to press ‘recheck all’ to get the edges back. This has been fixed. 

• Case 41205 

Edge contact with soft = 2 is modelled approximately in PRIMER using the automatic general 
method of cylinders on shell edges. If shledg = 1 (square edges) the cylinder is moved inward on 
the segment. This approximation works OK if the shell is not too warped and is thin with respect 
to its in-plane dimensions. If a very large thickness is set on the *CONTACT or 
*PART_CONTACT card, the cylinders can extend un-realistically behind the segment. The 
algorithm has been changed so that the size of the cylinder is now limited by the smallest length 
of the opposing edges of the segment. 
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Program crash 

• Case 42719 

Fixed a crash that happens while writing ptf/d3plot file from PRIMER. 

• Case 42324 

PRIMER no longer crashes when adding title for *ELEMENT_SHELL_NURBS_PATCH. 

• Case 42007 

Crash when pressing 'Sketch' in Constrained → Linear panel if there's nothing in the keyword. 
Now fixed. 

• Case 41976 

PRIMER will no longer crash while writing out *DEFINE_ALEBAG_BAG and 
*DEFINE_ALEBAG_HOLE keywords. 

• Case 41972 

When reading a model in which both master file and child include files were individual .zip files 
(i.e. not bundled into a single archive) the keyword reader got into a muddle about the status of 
these files. 

This did not matter unless they were written out again keeping the same compression mode, in 
which case either an error or a crash could occur because the code was in a muddle about 
whether they were a single archive or individual files. 

This is now fixed! 

• Case 41879 

If you sketched an ELEMENT_SHELL_NURBS_PATCH (or 
ELEMENT_SOLID_NURBS_PATCH) then PRIMER could freeze when rotating the model. 
This has been fixed. 

Quick pick 

• Case 41632 

When multiple models are in memory wildcard M?/nnn should select item nnn in all models. 
Instead one got messages about illegal model id. Wildcards for models has now been fixed. 

• Case 40824 

PRIMER crashed while trying to pick the <SPID> field of *ICFD_PART_VOL keyword in the 
keyword edit panel. Fixed this issue. 
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Read 

• Case 42780 

In *CONSTRAINED_NODAL_RIGID_BODY keyword, field <pnode> can now have negative 
node label. 

• Case 41635 

Importing IGES files could occasionally give errors when run with different numbers of threads. 
This has been improved. 

Renumber 

• Case 42644 

Condense materials function sometimes flagged material for removal that it should not. This 
happened when the material had field(s) which can be a load curve if negative and a real number 
if positive. Now fixed. 

• Case 41859 

On renumber selected panel if both declash options were active but only parts and/or NRBs 
selected for renumber, then NRB vs part declash would not be achieved. Now fixed. 

Scripting 

• Case 43120 

Previously, the ICFD panel would not handle unexpected user input (e.g. strings instead of 
numbers, floats instead of integers, etc.) correctly, usually resulting in the panel closing. This has 
now been fixed such that textboxes expecting data of a certain type (int, float) will only allow 
input of that type. 

The panel could also close when attempting to check for holes in non-structural parts, or when 
no rows of data were given. This has been fixed. 

• Case 42977 

Repeated stream of warnings in the HIC Area Tool due to change in the way Graphic function 
handles floating point values. Now fixed. 

• Case 41452 

Improved the consistency of all programs’ handling of the garbage collection memory allocation 
via command line and the main JavaScript panel.  

• Case 40102 

The following changes were made in SBA tool: 

1. Improved belt fitting in SBA tool. 

2. Automatic and manual options available to align shoulder block with seat belt. 

3. An option is added to install inertia bar. 
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4. An Option is added to update 1d belt lengths 

5. An option is added to set torso belt points to known points in the belt definition. 

6. A pop-up message is shown after the tool has finished to let user know about it. 

Seatsquash 

• Case 41844 

PRIMER defines a *DAMPING_GLOBAL card to the model while doing Dynain seatsquash. 
This model will not be accepted by DYNA if *DAMPING_PART cards are already present in 
the model. Now, PRIMER will delete all *DAMPING_PART cards in the model if user opts to 
add a *DAMPING_GLOBAL card. 

Selection 

• Case 43012 

The Key_In functionality for object menus causes a crash when used on unsorted types. Changes 
have been made to resolve this bug: 

When the user enters an unsorted type into the KEY_IN box, an error message will be issued. 

Spotwelding 

• Case 41768 

Making a weld on a very fine mesh with same part option on and edgedist set to default of 3.0 
could give a highly distorted weld connecting to shells on the same layer. Reducing edgedist 
would give the correct weld. The test for matching segment pairs has been made more robust so 
there is no longer a need to reduce edgedist (though the calculation will be more efficient if it is 
set to ~half size of the segments). 

T/HIS→PRIMER link 

• Case 40704 

PRIMER can now send load curves with large data (more than 1200 points) to T/HIS. 

Timestep 

• Case 42586 

When timestep of a discrete beam with INER=0 on section card is calculated, we could get a 
NaN error in the rotational calculation and the axial timestep was returned even though that may 
not be the smaller.  

Now the returned timestep is set to zero if we fail to calculate rotational timestep and a warning 
message given. 
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Undo 

• Case 41908 

Child panels of some of the editing panels in PRIMER does not respond after 'Reset' button in 
the parent panel is pressed. Fixed this problem. 

• Case 41707 

The 'undo' functionality was not working correctly when trying to restore parts of a model that 
included parameters: 

(1) If something which referenced a parameter, e.g. using ‘&something’, was deleted but the 
actual parameter definition of something remained, then when the deletion was undone the 
parameter reference to something could be lost, and the underlying value could also be wrong. 

(2) If parameters themselves were deleted, then the deletion operation was undone, the 
parameters might not be restored correctly. 

These two related but distinct problems have both now been fixed. 

Units 

• Case 38921 

Previously, when undergoing a unit change, PRIMER would change the values of SFA and SFO 
on *DEFINE_CURVES from 0.0 to 1.0 if the units change did not affect these curves. Since the 
LS-DYNA default value for these fields is 1.0, this did not affect the running of jobs. However, 
for consistency, now PRIMER will not change the values of SFA and SFO if a unit change has 
no effect, even if they are 0.0. 

User interface 

• Case 41322 

Sliders were not working correctly when going to negative values. It is rare that they can go 
negative, but it is possible. Problem resolved. 

Utilities 

• Case 41277 

Go Back button is added in Display → Options → Dyn Label Format for going back to main 
menu. After closing the panel, it will now open main menu of Display → Options 

Volume 3 

• Case 39790 

EM keywords will now have separate keyword headers rather than blocks of keywords. 
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Write 

• Case 42388 

PRIMER ptf reader was not writing out *ELEMENT_SOLID keywords properly when the 
number of nodes is more than 8. Fixed this problem. 

X-sections 

• Case 42178 

In the DATABASE_CROSS_SECTION edit panel, if you selected a node, chose 'Drag translate', 
moved the section, turned drag off and then changed L or M by typing in the field in the menu, 
the location of the plane reverted to the originally picked node. This has been fixed. 

ZTF 

• Case 42738 

Information for bolts did not always write correctly to the ZTF file which could result in a bolt 
appearing in D3PLOT in the wrong place. Now fixed. 

• Case 35346 

PRIMER can be run in batch mode to generate ZTF files. Any temporary PGP files generated as 
a part of those operations were, previously, not being cleaned up. This has now been fixed.  
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2.2 D3PLOT 

2.2.1 Bugs Fixed in 17.0 

Airbag 
• Case 42277 

If Trace Lines were being plotted on Airbag Particles, then the lines would disappear if the 
D3PLOT → T/HIS link was started. Now fixed. 

Blanking 

• Case 41948 

If multiple models were loaded into D3PLOT and the option to export blanking information 
from one model to another was used, then the blanking status was not always updated correctly. 

If the user blanked some items in one window and exported those settings to the other models, 
then it worked correctly. If the user then used the unblank all 'U' shortcut key in a window, and 
then exported the blanking status from that window then the blanking status was not copied 
across correctly. Now fixed. 

• Case 41945 

D3PLOT would crash if you set the object type to 'PART_TREE_ASSEM' and tried to select 
them in the Blank menu using the 'Vis' option. 

Blanking them via the Part Tree worked fine. 

Bug is now fixed. 

• Case 41904 

Blank by INCLUDE in D3PLOT will now blank Nodal Rigid Bodies and X-Sections defined in 
the include file. 

• Case 27653 

If *DATABASE_CROSS_SECTION definitions were defined in *INCLUDE files, then the 
cross sections were not blanked in D3PLOT when the INCLUDE file was blanked. This has 
been fixed in D3PLOT 17.0 but it also requires a ZTF file generated by PRIMER 17.0. 

Blob plots 

• Case 39767 

If a settings file was saved from a model displaying external data (Utilities → External Data) 
then some if the settings in the external data menu were not saved in the settings file and would 
be lost when the settings file was opened in a later session. Now fixed. 
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Composites 

• Case 41587 

In the Write menu when selecting a ply surface and using multiple windows, the rows showing a 
ply was selected for W2 and greater did not highlight. This has been fixed. 

• Case 40971 

It is now possible to select a ply surface for Entities and Elements in the XY data menu. 

Contacts 

• Case 42527 

If an INTFOR/CTF file was read into D3PLOT without a ZTF then D3PLOT numbered any 
contact surface sequentially from 1 and did not display the names of the contacts as it was only 
reading this information from the ZTF file. 

In recent versions of the INTFOR file, the contact IDs and names are written into the file but 
D3PLOT was ignoring these data. D3PLOT 17.0 now reads and displays these data correctly in 
menus if a ZTF is not available. 

Contour 

• Case 42312 

If the number of contour levels was set to 2, 4, 8 or 16 then elements with values close to a 
contour band boundary could be coloured incorrectly. This has been fixed. 

Data access 

• Case 43101 

From R10 onwards, LS-DYNA supported a new option (3) for the SIGFLG and EPSFLG inputs 
on *DATABASE_EXTNET_BINARY that removed the Stress Tensor (SIGFLG) and Plastic 
Strain (EPSFLG) from the d3plot/PTF files for solids. 

D3PLOT did not support this option and if used, D3PLOT would mis-diagnose the file as a 
Frequency Domain output file and display the time values as Hz . It could also incorrectly report 
some element results. This has been fixed in D3PLOT 17.0. 

• Case 42767 

If a model contained either spotweld solids or spotweld assemblies and only a subset of the 
spotwelds were defined using a material model that generated data for the additional data 
components defined in the DCFAIL file, then D3PLOT could plot the wrong data when 
displaying the DCFAIL data components. Now fixed. 
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Data components 

• Case 41860 

D3PLOT would crash if the command line was used to plot spotweld data for multiple 
components one after the other. 

 /other comp spotweld_force 

 /si 

would work, but if another spotweld component was then selected 

 /other comp spotweld_failure 

D3PLOT would crash. 

Bug is now fixed. 

Dialogue command 

• Case 42382 

If the command line (Dialogue Window) was used to generate an animated GIF, then the output 
file was always called ‘d3plot001.gif’ and was generated in the same directory that the results 
were read from even if the user specified a different filename or directory. Now fixed. 

• Case 42162 

When opening a model with the dialogue box command, it sometimes incorrectly picked up 
additional files like property files from a previously read model. This could cause corrupted 
blanking for example. Now this has been fixed. 

General 

• Case 42128 

The dialogue command /DEFORM REF_STATE SET_REF_STATE did not work with the 
option TIME_RS to specify the reference state by time. This has now been fixed. 

• Case 42078 

The min/max data values reported on plots for beam data components that vary along the length 
of the beam were wrong as they only considered values at one end of the beam (the contour bar 
was correct). 

Version 17.0 onwards correctly reports the min/max values from both end of the beams. 

• Case 42003 

When contouring streamlines and going to state 0, sometimes D3PLOT crashed. This has now 
been fixed. 
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Graphics 

• Case 42790 

When doing a MEASURE of 'Node to origin' the vector distance of the node to (0,0,0) is 
reported on the screen, but was drawn on top of the node label itself making both hard to read. 

This was caused by a graphics driver error and has now been corrected; the vector distance will 
now be drawn below the node label. 

• Case 42331 

If the option to use automatic transparency levels when contouring was turned on, then elements 
that should have been drawn 100% opaque were not rendered correctly and transparent elements 
behind them could still be seen. This has been fixed in D3PLOT 17.0 but there can still be some 
odd effects when nearly opaque items are drawn because D3PLOT does not sort everything and 
draw the furthest away first (e.g. this would be too slow to update for every plot during model 
rotation). 

• Case 42201 

If two models were loaded into separate windows and both windows were animated or rotated at 
the same time, then D3PLOT was much quicker than if the same two models were loaded into a 
single window. With large models the case with two models in the same window could be 10 or 
more times slower than having each model in a separate window. 

In D3PLOT 17.0 this has been resolved and two models in one window is now quicker than 
separate windows when rotating or animating. Screen picking items when multiple models are in 
a single window is still slower than using separate windows because D3PLOT has to look 
through the contents of all the models in the window to find the closest item. 

• Case 41950 

If a Solid part was being drawn with transparency and the part was intersected by a cut section, 
then the element borders were not visible on the cut face if element overlay was turned on. This 
is now fixed. 

• Case 41366 

When Oasys LS-DYNA software is used on very high-resolution devices (for example laptops 
with 3840 horizontal resolution, projectors with 4096 resolution) the graphics window text could 
appear much too big. Graphics text on these high-resolution devices should now appear at the 
correct size. 

However, the user interface is still undergoing development for display on such devices, and 
while text should be the correct size, some other symbols may still be too small. This is work in 
progress that will be fixed in due course. 
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Groups 

• Case 42205 

If a group had been deleted, selecting a group using quick pick could cause an error message to 
be written to the dialogue window and the group not being able to be selected. This has been 
fixed. 

JavaScript API 

• Case 42899 

D3PLOT crashed when a JavaScript called GetLabel where the item argument is not a number 
(NaN). This has now been fixed. 

• Case 42846 

The failure_plot.js script failed to write out the part info .csv file if the directory containing the 
D3PLOT file had a space in the pathname. Now fixed. 

• Case 42647 

Using fr_of_ref = MATERIAL in GetData JavaScript command provoked an error message. This 
has been fixed. 

• Case 41861 

QueryDataPresent for LSDA components caused D3PLOT to crash. This has been fixed. 

Licensing 

• Case 42369 

If T/HIS was started from within D3PLOT and no T/HIS licenses were available, then T/HIS 
would immediately exit and that could cause D3PLOT to crash. 

In D3PLOT 17.0 if no licenses are available, T/HIS will exit gracefully and D3PLOT now 
displays an error message in its dialogue window saying that no T/HIS license are available. 

Manual 

• Case 38454 

If a web browser was already open on Linux and the user tried to open a manual page then the 
program would hang. The manual page should now correctly open on a new tab in the existing 
web browser session. 

Measure 

• Case 40254 

Minor fixes for sketching part-part measures.  
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In D3PLOT 16.x, if you sketch the parts in one side of the part-part measure, then delete that 
measure, the parts were still sketched. Now that sketching is removed when the measure is 
deleted. 

In D3PLOT 16.x, if you sketch the parts in one side of the part-part measure, then add further 
parts to that side, the sketch does not show these newly added parts. Now, when you click Done 
in the Add parts menu, these parts are sketched too. 

Menus 

• Case 42142 

The static area at the top of the XY Data panel became smaller in height in the Zoom and Labels 
modes. When then returning to the main buttons, the lower button row became invisible because 
the static area did not become taller again. Now the static area updates immediately when 
changing back to the main panel mode. 

• Case 39962 

D3PLOT sessions files possess knowledge of associated results files. Previous versions of 
D3PLOT contained a subtle bug in terms of results file selection. If users select a session file for 
loading, then switch to settings file mode and choose one, the results files corresponding to the 
session file could get (possibly incorrectly) associated with the newly chosen settings file. This 
has now been fixed. 

Nastran 
• Case 41737 

Element strain energy results in a Nastran OP2 file could only be displayed for the first subcase. 
Subsequent subcases all had zero values. This has been fixed. 

Quick pick 

• Case 42304 

When you opened D3PLOT the quick pick menu defaults to blanking PARTs, if you then 
cancelled the 'Open Model Panel' without reading in a model the quick pick menu changed to 
blanking NODEs.  

If you then opened a model (from the GUI or drag n drop) the default did not change back to 
PART.  

Problem now fixed. 

Read 

• Case 42332 

If a CPMFOR file was read into D3PLOT by itself without the PTF/D3PLOT file, then the file 
was sometimes not read correctly and D3PLOT would report a problem with the state times 
when scanning the contents of the file. Now fixed. 
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Scripting 

• Case 41452 

Improved the consistency of all programs’ handling of the garbage collection memory allocation 
via command line and the main JavaScript panel. 

Selection 

• Case 42868 

If in an object menu (BLANK, WRITE, XY-DATA) the user selected one of the spotweld types 
and tried to select a spotweld using the 'keyin' option, then D3PLOT could either report that the 
ID did not exist, or it could select the wrong spotweld. Now fixed. 

Selecting spotwelds either by screen picking or clicking on rows in the menu worked correctly 
and selected the correct item. 

Session 

• Case 42804 

A sessions file with XY data curves transferred from D3PLOT to T/HIS was not restoring the 
curve labels and graph title. This has been fixed. 

• Case 42636 

The selected states in an envelope plot were not being reloaded correctly when a session file was 
read into D3PLOT. This has been fixed. 

• Case 42055 

Once models have been read into D3PLOT, it is not possible to open any session file, even if all 
the models have been deleted. In order to make this clearer in the File → Open Model menu, we 
have changed the greyed out 'Session file' option to read 'Session file (when D3PLOT started)'. 

Settings file 

• Case 43171 

If D3PLOT didn't have any models loaded and the user went to the File menu in the top toolbar 
and then selected the 'Settings File' option, D3PLOT could crash. 

In D3PLOT 17.0, any options in the 'File' popup that should not be available when no models are 
loaded are now greyed-out so that they cannot be selected. The processing of any shortcut keys is 
also blocked when no models are present. 

States 

• Case 42270 

If a D3PLOT (PTF) file and a D3EIGV file were read into the same Window in D3PLOT and 
the D3EIGV file was read second, then D3PLOT would crash if the state was then changed. 
Fixed. 
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• Case 41729 

Suppose that there are multiple models open in different windows on different pages in the 
layout and that the model with the maximum number of states is not currently active. The range 
for the state slider is then determined by the maximum of state numbers across the active 
windows. Sometimes the left and right arrows on the keyboard still moved the slider out of the 
range (making it invisible) up to the maximum state number in the session, which is not in an 
active window. Now the keyboard arrows only move the sliders as far as the range currently 
mapped allows. 

T/HIS link 
• Case 41968 

The locations and sizes of T/HIS graphs opened using the D3PLOT → T/HIS link was not being 
written correctly to settings files. 

This meant that reading the settings file did not position them in the correct place. 

It now writes the correct size and positions. 

Text 

• Case 42083 

The SWAP_TITLE option sometimes crashed for windows with short titles (at most 40 
characters). Now fixed. 

User interface 

• Case 42852 

Data components like principal stress and principal strain were sometimes abbreviated as 'Princ' 
or misleadingly as 'Prince' on contour bars and a few other windows. Now the word 'Principal' is 
spelled out in more places. 

• Case 42814 

If multiple models were read into D3PLOT using the 'Search Directories' option, then dragging 
the state slider did not update the state number and time until the mouse button was released. 
They should have updated as the slider was being dragged. This has been fixed. 

• Case 42678 

If you reopened the XY Data menu the previously selected component was shown but greyed 
out. Once an entity had been selected it ungreyed but swapped to the default component. This 
was confusing. 

Now, when the menu is reopened the component is blank until an entity is selected. 
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User defined 

• Case 42424 

If a user defined data component was setup for a Thick Shell and the data component used values 
that varied through the thickness from one integration point to another, then all of the through-
thickness values were calculated using the values from the last plotted integration point. Now 
fixed. 

Variables 

• Case 42118 

Extra history variables were written incorrectly to *INITIAL_STRESS_SHELL. This has been 
corrected. 

Views 

• Case 43016 

Added dialogue commands +XZ and -XZ as alias for the existing +ZX and -ZX setting the view. 
The new spellings are more consistent with what the buttons on the view control panel say. 

Volume 3 

• Case 42138 

If D3PLOT tried to read in a model containing results for the Electromagnetic domain type 23 
(EM_FEMSTER_NODE) then it would generate an error message about an unsupported domain 
type and the files would not be read. In D3PLOT 17.0, this domain type is now supported. 

Write 

• Case 42156 

When writing out HEX20 topology (Write → Keyword data) the topology of the first HEX20 
element was written incorrectly. This has been fixed. 

• Case 39699 

If in the Write menu an LSDA (binout) derived vector data component was selected, then the 
option to output 'VECTOR - all three terms' generated a single column of values which were all 
zero. This has been fixed in D3PLOT 17.0 and all three X, Y and Z values are now output. 

ZTF 

• Case 42737 

When running the D3PLOT → T/HIS link, any Thick Shell elements defined in 
*DATABASE_HISTORY_TSHELL cards were not marked as a 'history' element in D3PLOT 
with a cross and the TSHELL entry under Database in the Entity menu remains greyed out. Bug 
is now fixed. 
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• Case 42330 

If a Femzipped compressed file called 'D3PLOT.fz' was read into D3PLOT, then D3PLOT 
would fail to find and read the ZTF file unless it was named either 'D3PLOT.ztf' or 'ztfile'. 

From D3PLOT 17.0 onwards, if D3PLOT does not find a ZTF file that matches the 
PTF/D3PLOT filename, it will now always look for the most recent ZTF file in the directory and 
use that. If the directory contains more than one ZTF file, then a warning message is now 
displayed in the 'Open Plot File' menu and the Dialogue window and the option to automatically 
open the files is turned off. This allows the user to select a different ZTF file before opening the 
model. 
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2.3 T/HIS 

2.3.1 Bugs Fixed in 17.0 

Curve table 
• Case 42837 

A CSV file written out from the curve table would cause Excel to issue errors about a corrupt file 
when read in. This was caused by the first header being 'ID' which makes Excel assume the file 
is a 'SYLK' file. The header is now written as 'Id'. 

When right-clicking on a row in the properties part of the curve table the on/off status of the 
‘Annotate’ tick mark was being decided based on the previously selected row. This has been 
fixed. 

The add label checkbox did not always display the label when turned on, you had to switch 
between 'Automatic' and 'User defined' to get it to display. This has been fixed. 

Curves 

• Case 42272 

If in the Write menu the user selected an existing filename and the options to either 'Overwrite' 
or select a 'New File' were displayed and the user instead chose the option to select a different set 
of curves, then 2 sets of buttons were displayed on top of each other when the user had finished 
curve selection and pressed 'Apply'. Now fixed. 

• Case 42050 

In FAST-TCF, when the dB operation was called using a reference value of 0 or below, the error 
handling for the function was not correctly resetting the value to its default. This has now been 
fixed. 

• Case 40809 

When using the T/HIS link in D3PLOT, if an additional model was read into D3PLOT with the 
'Extract curves to match' option selected but not all the entities required to extract the curves 
were present, this could cause some issues. This has been fixed and the correct number of error 
curves will be produced to replace any missing data. 

FAST-TCF 

• Case 42379 

If a single input curve was passed to the SUM operation, then there was some incorrect 
behaviour, either causing an error curve or appending zeros to the output curve. This has been 
fixed and now the output is equal to the single input curve. 
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• Case 42378 

If a FAST-TCF script was written from a session containing multiple models, then depending on 
which graph(s) were being captured and what data the graph(s) contained, there could be an 
issue with model indexing in the generated FAST-TCF script. 

A new option has been added to the FAST-TCF write panel, allowing the user to choose whether 
to refer to models by their index in the current session or their index in the list of models 
required to produce the curves in the script. This option can be set with the 
ftcf_write_required_models preference. 

For example, say there are three models in a session: M1, M2 and M3. Graph 1 contains data 
from M3 only and Graph 1 is being captured by a FAST-TCF script. Then there is now a choice 
as to whether to refer to M3 as model 1, so it could be run in a session with only one model, or 
model 3, so it could be run in the same session it was captured from and produce the same 
results. 

• Case 42130 

Going over the 80-character limit for curve labels in FAST-TCF scripts was causing a crash. 
This has been fixed: the script will now carry on, the label will be truncated to 80 characters and 
the user will be warned. 

• Case 41758 

There was a bug introduced in 16.0 causing the 'all' command not to work in FAST-TCF data 
extraction, such as: 

node all displacement z 

This was only reading data for the first node instead of all nodes. This has been fixed. 

Graphs 

• Case 41524 

If you had multiple pages and created a new graph using the settings from another graph, the 
new graph would get created on the current page as expected, but also on all the other pages that 
the graph with the settings to copy from was on. This has been fixed. 

• Case 40821 

If the 'Align with Y = 0' option was enabled for the Y2 axis, then when the graph was autoscaled, 
it would only scale to fit the curves on the Y-axis. This meant the curves plotted on the Y2-axis 
could be partly off the graph. This has been fixed, so autoscale now scales both axes to guarantee 
all curves are fully visible if 'Align Y = 0' is enabled. 

Manual 

• Case 38454 

If a web browser was already open on Linux and the user tried to open a manual page then the 
program would hang. The manual page should now correctly open on a new tab in the existing 
web browser session. 
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Menus 

• Case 42534 

Fixed a bug where T/HIS sometimes crashed on opening on a secondary monitor. 

• Case 40840 

Clicking on the Y2 axis on a graph and then selecting the 'Add Second Y Axis' option did not do 
anything if the graph was greyed out. This has been fixed. 

Operations 

• Case 42519 

The automotive filter operations C60, C180 etc suffered from numerical errors due to floating 
point rounding if the input curve was regularized with too small an interval. The size of the 
interval at which the problem would occur also depended on the characteristics of the input curve 
but could happen at around 1.0E-6 to 5.0E-6 for the C60 filter in some cases. This bug has now 
been fixed. 

Preferences 

• Case 41647 

On Windows, if there was a file named 'oa_pref_old' or 'oa_pref_tmp' with read-only 
permissions, then saving any preferences would fail. This has been fixed. 

Read 

• Case 42596 

The new format of the em_nodout.dat file, output using the keyword 
*EM_DATABASE_NODOUT, had 15-character wide fields rather than 12 previously. This was 
not being read correctly. This has been fixed. 

Scripting 

• Case 41452 

Improved the consistency of all programs’ handling of the garbage collection memory allocation 
via command line and the main JavaScript panel.  

Session 

• Case 42838 

A T/HIS session file would sometimes not read in all the saved curves. This was due to an 
internal error and has been fixed. 
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• Case 41628 

The file selector used to select a model in the session file menu opened in the home directory. It 
now opens in the current directory. 

• Case 41301 

After reading in a session file referring to multiple models, only the last model in the list was 
selected. Now the selection status of the models when the session is saved is retained when the 
session is retrieved. 

T/HIS link 

• Case 40600 

If when running the D3PLOT → T/HIS link the T/HIS session was fully undocked, then trying 
to drag the vertical green divider bar to resize the T/HIS menus did not have any affect. This has 
been fixed. 
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2.4 REPORTER 

2.4.1 Bugs Fixed in 17.0 

FAST-TCF 
• Case 41735 

When reading a T/HIS item containing a FAST-TCF script, REPORTER would remove any 
semicolons (e.g. found in entity names). Semicolons are now preserved. 

Graphics 

• Case 42402 

If REPORTER was launched on a server running a virtual display using Xvfb versions 1.18 or 
later, REPORTER would abort with the message 'Floating point exception (core dumped)'. Now 
fixed. 

JavaScript API 

• Case 42885 

Arguments for methods that are integers are now checked more thoroughly. A warning is given 
if the number is not an integer and the number will be rounded to the nearest integer 

Arguments for methods that are numbers are now checked for validity. If the value is NaN (Not 
a Number) then an exception is now thrown. 

• Case 42600 

Problems encountered when modifying individual Table cell border widths via the JavaScript 
API, especially when reducing the existing border width, have been fixed. 

Preferences 

• Case 42328 

With 'Snap to grid' enabled, items on the page no longer snap when selected (only when moved). 
Changed behaviour of snapping such that items snap to grid based on chosen reference corner 
defined in preferences. When snap size exceeds nudge size, nudge now uses snap size instead to 
ensure nudging always possible. 

Tables 

• Case 43091 

Custom cell borders in Tables are no longer displayed if the table line colour is set to 'none'. Cell 
Borders window now starts with the custom border width set to the current line width setting for 
the table rather than 'none'. Non-custom border widths no longer revert to the original line width 
of the table when adding new custom borders. 
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• Case 41773 

Sizes of rows/columns in tables no longer automatically reset unless the 'Reset heights' or 'Reset 
widths' buttons are explicitly pressed. A new checkbox has been added to the Edit Table Dialog: 
'Fix overall table size while adding/deleting/resizing rows and columns'. When unticked, 
row/column operations can adjust overall table size. When ticked, rows/columns scale 
proportionally after each operation to fit original table size. A similar checkbox has been added 
to Edit Autotable Dialog, applied only to columns. 

Text 

• Case 41639 

REPORTER could occasionally write error messages 'QFont::setPixelSize: Pixel size <= 0' to 
the terminal window on Linux. This has now been fixed. 

User interface 

• Case 42660 

The close button ('X') has been enabled for all dialog windows.  

• Case 41935 

Trying to close a session with modified files prompts the user to save changes. REPORTER 
would close anyway even if the user cancelled the save dialog. Now fixed. 

Variables 

• Case 41676 

Templates containing the text '%CURRENT_PAGE%/%TOTAL_PAGES%' would result in an 
error message when written to PowerPoint. Now fixed.  
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2.5 SHELL 

2.5.1 Bugs fixed in 17.0 

Graphics 
• Case 42761 

Fix for an unwanted message while exiting the SHELL with the cross ('X') button in the top-right 
corner. 

Memory 

• Case 42917 

Fixed an issue in the SHELL submit panel for Memory2 unit conversion (Words/Megawords) 

Multiple jobs 

• Case 42252 

While launching different REPORTER lists from the same SHELL session, the outputs were 
getting mangled. Fixed this. 

Output 

• Case 42610 

Added new Input/ Output options into the SHELL - INIT, D3PROP, General Print File(.root), 
Module DLL. 

• Case 40614 

The Output files option for BEM files has been corrected for the LS-DYNA submission via the 
SHELL. 
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3 Enhancements 

The enhancements and bug-fixes for each program have been broken down into a series of 
topics.  Within each topic enhancements and bug-fixes are listed by case ID. 

3.1 PRIMER 

3.1.1 Enhancements in Version 17.0 

Belts 
• Case 38788 

A new button 'Set all segments' is added in Seatbelt mesh panel, which will set all segments for 
the belt to element settings for the current segment. 

• Case 35170 

SeatBelt path can now be defined via an input from a CSV file. 

Checking 

• Case 42052 

A new preference 'PRIMER*user_max_joint_node_separation' has been added. If defined, joint 
node coincidence will be tested against this value which may be more stringent than LS-DYNA's 
own test and error reported if it fails. 

• Case 41873 

In PRIMER tools in checks under Read Dyna, new categories Load Profile, Contact Profile, Mes 
Profile, and Decomposition have been  added to generate load distribution graph from DYNA 
results. 

It will allow user to view cost information of different categories across all the processors in a 
bar graph mode. 

There are various interactive controls available on the bar graph. 

• Case 40845 

[RESET] button added for Check Options panel. 

• Case 39585 

Inside Check → Elem Qual, the 'Recheck' button now just does a recheck of the element quality 
and will not recheck of the entire model. 

• Case 39583 

Enhancements made for the Check → Options panel Category: Quality 

- Different criteria for element quality checks can now be set for different element types. 
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- The panel has been redesigned/ reordered to enhance user experience. 

- Element and Added Mass checks and weights can now be modified in the 'Quality' category in 
addition to the individual 'Timestep' and 'Added mass' categories and the contour settings panel. 

- Users can now save the element quality check options to the preference file using the new [save 
element quality settings to oa_pref file] button. 

- The min length criterion works slightly differently. If positive, assume same unit as model. If 
negative, assume mm (aka. value will be divided by 1000 when checking to match model unit if 
model is in metres). 

Command files 

• Case 40302 

In PRIMER 17.0, by default, the Checkpoint files panel is now disabled. However, they can be 
activated via the preference 'show_checkpoint_files'.  

Also added a command line options '-checkpoint_dir' and '-show_checkpoint_files' to control 
Read/Write of Checkpoint files in PRIMER. 

Comments 

• Case 39247 

A new option is added in the model write panel of PRIMER. This option can be used to control 
the writing of comments containing the timestamp, DYNA and PRIMER versions in the key 
format. 

Connections 

• Case 40542 

2pt bolts will now be made directly between solids without the need to coat with shells. 

Contour 

• Case 38773 

A new option named 'Only (visible elements)' is made available on the drop down upon R mouse 
click of contour bar in any CT/ SI mode. True 'only' is applied to all visible (aka. drawn) 
elements at that instant. 

Element Quality → Failed Criteria Contour settings 'Rigid Elements' and 'Uncalc'd Elems' are 
now automatically set to 'Not Drawn' when limiting elements according to contour band click. 
Settings will be reset to default when the middle mouse is clicked. 

Load Shell Direction Contour settings 'Uncalc'd Elems' (aka. Not shell) is now also automatically 
set to 'Not Drawn' when limiting elements according to contour band click. Settings will be reset 
to default when the middle mouse is clicked. 
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Control 

• Case 40360 

Added popup option for <TYPE> field in the 
*CONTROL_MPP_DECOMPOSITION_ARRANGE_PARTS keyword. 

• Case 40238 

A new line in CONTROL_MPP_PFILE can now be added anywhere as a 'plus' button has been 
provided for every line. Also, the existing 'Add pfile line' has been reconfigured to add a line at 
the top. 

Dummies 

• Case 41119 

Added a new 'Measure' button to the Tools → Dummies panel to select and measure the plane 
angles of the Dummy model beams. 

• Case 41053 

Added an option to write out the DUMMY positioning angles into an external *.csv format. 

• Case 40946 

Added 'Dummy Finger Positioning' and 'LSTC Dummy Conversion' in Safety panel. Also added 
these options in PRIMER manual. 

Element quality 

• Case 40647 

New switch [Ignore rigid elements] added to the Check → Options → Quality panel. 
Corresponding new preference 'ignore_rigid_element_checks' is also available now. 

• Case 37546 

New 'Modify criteria' option in contour bar drop down for all 'Elem Qual' contouring that opens 
the Check → Options panel. 

Explode 

• Case 41919 

The 'Explode' function in previous versions of PRIMER supported three different factors (scale 
factor, thickness factor and size factor) that could control the size of the exploded view. These 
were found to be somewhat opaque in nature and the presence of three different factors was 
found to be confusing. This has been changed in PRIMER 17.0.  

The factors have now been rationalised and a single all-encompassing 'spacing factor' (with a 
default value of 1.0) has been added. The new spacing factor can range between 0.0 and 10.0 
with a larger value resulting in a more separated view. Older macros that made use of the 
deprecated factors will cease to work. 
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• Case 41782 

A new 'Drag' option has been added to the 'Explode' function in PRIMER. Drag is only available 
for parts and that only when 'Detach parts' is set to 'Yes'. 

Drag is available when Explode is turned on and allows users to pick and drag parts along the 
explosion direction. The explosion direction is an existing option and can be any one of 'Default' 
- explosion origin → part centre - 'X', 'Y', or 'Z'. 

Filename 

• Case 40615 

When compression was first added to PRIMER, we adopted the following filename syntax: 

- name.key became name.key.gz for 'gz' compression. 

- name.key became name.zip for '.zip' compression. 

This followed conventional Linux and Windows syntax respectively, but the point has been 
made by users that 'name.zip' obscures the original extension, making it difficult to work out 
what this was.  

In addition, now that PRIMER can write binary format files it can be important to know whether 
'name.zip' contains ascii file 'name.key' or binary file 'name.kby'. 

Therefore, this syntax has been modified in PRIMER 17.0 so that the '.zip' extension is appended 
to the existing ascii filename, rather than replacing it. Therefore, the syntax is now 

- name.key becomes name.key.zip when using '.zip' compression. 

The original behaviour can be restored by setting the preference  

PRIMER*keyout_zip_extension: replace 

Frequency 

• Case 42015 

A new PRIMER warning has been added for FREQUENCY_DOMAIN_FRF to let users know 
that MDMIN/MDMAX has to have a positive integer when RESTRT field is either 1 or 3. 

Graphics 

• Case 40962 

There is now an option to anti-alias the lines drawn for element overlay and all wireframe 
graphics. 

Anti-aliasing is a process which reduces the 'jagged edges' appearance of lines that are drawn at 
any angle other than vertical or horizontal, making them look smoother. On most displays it also 
makes the lines look slightly thicker, and generally gives a better appearance. 

For backwards compatibility this is not the default, but it can be made so by using the 
PRIMER*line_antialias preference. 
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Image 

• Case 40708 

Default Image Format for all the Oasys Suite 17.0 products is now changed to PNG_24 from the 
previous default of JPG_24 

Implicit 

• Case 39033 

Added option to retain material ID and title in Control → Convert to Implicit. So now if Convert 
to Implicit is applied with these options ticked then it will be able to retain material ID and title. 

Include transform 

• Case 39844 

Enabled PRIMER to read in keyword 'TRANSLATE' as Dyna keyword 'TRANSL' in 
*INCLUDE_TRANSFORMATION definitions. 

Integration 

• Case 41274 

PRIMER and T/HIS will print messages in the command window to let user know after the 
curve data is shared between the two. 

JavaScript API 

• Case 42540 

The constructor for the Belt class in PRIMER 17.0 internally supports additional properties. It 
also uses default values that are more in line those used by the Seatbelts menu, thereby resulting 
in a closer match. 

The constructor now also supports options to specify entity types and a list of entities (via a flag) 
that the new belt can fit around 

Some new properties are now supported by the Belt class. Additionally, the following methods 
have been added: 

- InsertPoint() – adds points anywhere along the belt path 

- Fit() – fits the belt 

- Generate() – grabs properties from an existing mesh (if one exists) and (re)generates it or 
creates a new default mesh if one does not exist 

- GetMesh() – retrieves some mesh segment properties 

- SetMesh() – modifies some mesh segment properties and regenerates the mesh 

Using these new additions, it is now possible to create a fully-functional belt or to modify an 
existing one and to fit it and re-generate the belt mesh 
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• Case 41288 

Users can now control overlay settings (No Overlay, free edges, feature lines…) through JS-API. 

• Case 41268 

Users can now control colour settings (Background colour, text colour, Node colour....) in 
Display → Colour through JS-API. 

• Case 41177 

When calling -ls_opt=... on the command line additional arguments can now be passed via -
ls_opt_arg=... More arguments have been added to allow control over morphing connections. As 
a result, the syntax for optional arguments when calling -ls_opt has changed as follows: 

-ls_opt_arg='OUTPUT: [filename]' - gives the output filename. 

-ls_opt_arg='REMAKE_CONX: [TRUE/FALSE]' - whether connections are remade 
after morphing (default: TRUE). 

-ls_opt_arg='REMAKE_CONX_ERROR: [TRUE/FALSE]' - whether a failure to remake 
an initially realized connection results in Error Termination (default: TRUE). 

For example: 

... -ls_opt_arg='OUTPUT: output_filename.key' -ls_opt_arg='REMAKE_CONX_ERROR: 
FALSE' 

If an argument name is omitted, -ls_opt_arg='value', then the value will be assumed to be the 
output filename. 

• Case 41019 

The text within Textbox widgets can now be horizontally aligned by using Widget.LEFT, 
Widget.RIGHT or Widget.CENTRE. 

• Case 41015 

The onClick event can now be used for label widgets 

• Case 41014 

Added new model properties: compress, compressMode, binary, masterAscii, and fileStartAscii. 

• Case 40810 

Visibility() and Labels() PRIMER JS functions of global class in enhanced. These functions can 
now be used to return the visibility and label visibility status of entities. 

• Case 39079 

A new slider widget has been added to the Widget class. 

• Case 39062 

A new 'type' property has been added to widgets. So, now when a widget is created, its type can 
be found later using 'type' property. 
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• Case 38784 

Added member function in mechanism class to add and remove part, part set, and node set in 
Mechanism → Assembly: 

- m.AddPartToAssembly(index[integer], pid[integer]) 

- m.AddPartSetToAssembly(index[integer], psid[integer]) 

- m.AddNodeSetToAssembly(index[integer], nsid[integer]) 

- m.RemovePartFromAssembly(index[integer], pid[integer]) 

- m.RemovePartSetFromAssembly(index[integer], psid[integer]) 

- m.RemoveNodeSetFromAssembly(index[integer], nsid[integer]) 

• Case 38782 

Model Autofix can be done using JavaScript API[m.Autofix()] 

• Case 38779 

A class function 'SetMeshingLabels' is added into the BELT class to allow setting of initial 
labels of entities for the Seatbelt mesh. 

• Case 37697 

Added a global class function FlagsAvailable() to PRIMER JavaScript API. This function 
returns the number of flags that can be requested though the script. 

• Case 33756 

DATABASE_ENVELOPE is added to the JavaScript API. 

Keyword 

• Case 42278 

Added keyword editor for *ELEMENT_SHELL_NURBS_PATCH. 

• Case 40541 

AN(i) field in AIRBAG_PARTICLE can now take in load curves as input. 

• Case 39764 

LS-DYNA has an optional 'i10' keyword format which is the same as the normal 'small' format 
except that any data fields less than 10 columns wide are promoted to become 10 columns wide. 
This allows items to have labels greater than 99,999,999 without having to use as much extra 
space as the 'large' format (which promotes all data fields to 20 wide). 

This 'i10' format has been added to PRIMER which means: 

- Keyword files written in this format can be read. 

- Keyword files can be written in this format. 
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- Internal 'soft' limits on labels now consider this, with the option of choosing between the single 
precision LS-DYNA limit of ~2e9 or the full 9,999,999,999 that double precision LS-DYNA can 
handle. 

When labels become too large for 'small' format PRIMER aims to promote the output format of 
files to the most compact format that can represent the data. So, it will aim to use 'i10' format 
instead of the wider 'long' format, however 'long' format remains fully supported. 

Materials 

• Case 39150 

Added new checks for no data specified in ADD_EROSION card and for curve and table IDs. 

• Case 32502 

Multiple user-defined materials can be created with specific field headers using CSV files. Field 
type(integer/float/lcur/table) can also be defined for each field. Checks for load curves and tables 
have also added to PRIMER for user-defined materials. 

Measure 

• Case 40336 

Added new measure mode: Node to Plane. 

• Case 39905 

Added text boxes that shows the distance projected on coordinate planes in measure panel. 

Mesh 

• Case 41208 

An option to provide user defined meshing parameters is added under 'Program' which has 
helped achieved a good quality mesh around spotwelds in the vehicle after HAZ spotwelds 
creation. 

• Case 39086 

The original display is maintained after area remesh. 

• Case 39084 

Added ability to remesh multiple parts in one operation using Area remesh. 

Model build 

• Case 41701 

Changed the text in the popup for Model → Build. 
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Morphing 

• Case 42113 

When creating morph boxes, nodes should not be contained in more than one box at a time. 
When attempting to create a morph box where nodes are already in another box, there is now a 
new option to switch between the following behaviours: 

- PRIMER skips the nodes already contained in other morph boxes and creates the new box only 
with the selected nodes which are not already contained in other morph boxes. 

- PRIMER reports an error when nodes are already contained in another box and terminates the 
morph box creation. This is the same behaviour as in older PRIMER versions. 

• Case 42097 

The MorphBox JS API constructor has now a new optional property 'points' on the options 
object to attach the box to predefined morph points. If these points are created with the 
MorphPoint constructor, this gives more flexibility on the geometry and combinatorics of morph 
boxes. 

• Case 41236 

In addition to high order morph boxes, the morphing Create tab now also allows to create 
multiple linear morph boxes next to each other. In both cases the morph points form a uniform 
grid of cuboids. The behaviour while morphing is different: 

In a high order box, the mesh can be deformed more smoothly, but nodal coordinates do not 
always follow exactly the movement of the morph points or drag handles, but often only by a 
fraction. 

In multiple linear morph boxes, there are generally discontinuous tangent directions, for example 
sharper bends in parts going from one box to the next, but the morphing is localised to the 
smaller boxes at the morph points or handles dragged. 

To distinguish high order boxes from these new multiple linear boxes, the drawing of edge, face 
and internal morph points on high order boxes has been changed to use diamonds instead of little 
cubes. 

• Case 39315 

In the morphing panel, the number of clicks required to perform a morphing operation (in 
Selection mode) has been reduced, e.g. turning on Selection mode will automatically clear any 
previous selection and turn on Select, if some drag handles have been selected changing the drag 
direction will automatically turn off Select and turn on Drag, etc. 

• Case 38617 

When morphing a panel, any connections that are attached to that panel will be automatically 
found by PRIMER and will be morphed along with the panel. Any connections that have been 
morphed, since their last remake, can then be viewed in the Connection Table via the 'Table' 
button on the morph panel, or remade via the 'Remake' button on the morph panel. This 
functionality can be turned on or off via the tick box 'Morph Connections' on the morph panel, 
the state of which can be saved in the preference <morph_connections>. A warning will be 
issued if the axes of any cad type bolts are altered by morphing. This warning can be turned on 
or off via the preference <morph_cad_bolt_warning>. 
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This morphing functionality has been added to the JS-API. Connections will be found 
automatically by PRIMER when adjusting the positions of morph points. If any morph points 
have been moved, MorphBox.ApplyMorphing() must be called before any morphing occurs in 
an interactive session. 

New functions have been added to the JS-API: 

- MorphBox.SetMorphConnections(status) - Turns Morph Connections on or off. 

- MorphBox.FlagAllMorphedConnections(model, flag) - Flags all connections in <model> that 
have been morphed since their last remake. 

- MorphBox.FlagMorphedConnections(flag) - Flags all connections that have been morphed by 
MorphBox since their last remake. 

Multiple models 

• Case 40196 

Under the model list, the model drop-down menu has been made to have delete, copy and write 
options. 

Orient 

• Case 40319 

ORIENT → INTERPOLATE tool enhancement: 

- Interpolate tool now pops up as new window. 

- There is now an orient interpolation preview. 

- Original mode: ‘Search Distance (Default)’ 

> Modified distance and order sliders and textboxes.  

> Contour plot according to preview. 

- New mode: ‘Select Items to Interpolate’ 

> Manually select nodes to interpolate via NODE(s), SHELL(s) and PART(s).  

> Includes algorithm that automatically determines boundary nodes to fix. Option whether to 
fix free edge nodes at the boundary also available. 

• Case 39635 

Consider_INCL_TRANSFORM is shifted to new position and can be found beside 'offset' for 
ORIENT panel. 

Output 

• Case 41689 

The output of floating point values in keyword output files has been speeded up dramatically. 
Speed-ups vary since different files have a different mixture of integer and floating point values 
to write, but typical speed improvements are between 2.5x and 4.0x. 
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This can result in some minor changes to the 8th significant figure of single precision floating 
point output, typically ±1 but occasionally ±2 at that digit. Single precision floats are only 
accurate to '7 and a bit' significant figures, so these differences have no real significance. 

Other changes are that unnecessary trailing zeros are omitted from numbers (that is a value that 
was written 2.00000 is now written 2.0), and the precision with which values in the range ±[1e-2, 
1e-3] are output in limited field widths has been improved by changing from exponential to non-
exponential format. 

• Case 40930 

One of the options in the pre-output setup panel is to set the output format of a keyword file to 
'keep original'. For each master and include file this uses the same LS-DYNA format (small, i10, 
large) and compression method (none, gz, zip) that was used when the file was originally read. 
However, it did not reuse binary format, meaning that if a file was originally binary it would be 
written out in ASCII unless binary format was explicitly selected. 

This has now been modified to include binary format as part of the 'keep original format' 
process, and it works as follows: 

- On input, the original binary format of the file is detected and remembered. This is based on 
whether the *START_BINARY keyword is present in the file. 

- On output, if 'keep original format' is selected then a file which was read in binary format will 
be written out in that format. 

Parameter 

• Case 33928 

When merging two models with parameters, there is the option to 'Merge & rename' parameters 
with the same name and value. This did not consider parameter expressions in the past, but now 
it does. 

Expressions are now merged with this option when they have got the same name, value and 
expression string as well as all parameters referenced by the expression in the first model can be 
merged with the equivalent parameters with the same name referenced by the expression in the 
second model. 

Part table 

• Case 39053 

Part compare table can be written out as an excel/xlsx file with images. The differences in 
parts/models are highlighted in red. 

Part tree 

• Case 40835 

Users can now Add, Remove or Replace entities to Clipboard using quick pick. 
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Pedestrian 

• Case 40257 

Now both impact point name as well as the HIC value can be displayed at the same time from 
the HIC area tool. 

Penetrations 

• Case 40364 

On the contact depenetrator, switching between Parallel and Orthogonal sometimes requires too 
many clicks. Now dragging with the right mouse button has got the same effect as the opposite 
of these two options: 

- When dragging along the selected direction is active, then the right mouse button will drag 
orthogonal to the selected direction. 

- When dragging orthogonal to the direction is active, the right mouse button will move nodes 
along that direction. 

Also, the word Parallel on the button has been changed to Along to make the wording more 
consistent. 

Preferences 

• Case 40945 

Added 'Save to oa_pref' button in Display → Colour panel. All the options in Display → Colour 
panel will be saved to oa_pref. 

• Case 39060 

An oa_pref option for tolerance has been added to use when doing part replace node merge. 

• Case 39040 

New oa_pref options for 3D graticule have been created 

Read 

• Case 40298 

Changed the button name for reading zip file from 'Abort Keyin' to 'Abort Read'. 

• Case 39991 

PRIMER used to read include file paths with length more than the DYNA prescribed maximum 
length. PRIMER is expected to issue a warning when these include paths are provided in the 
model. Added appropriate warning message for this. 
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Scripting 

• Case 42412 

The script has been verified to make sure that the created XML file corresponds to dyna errors 
correctly. 

• Case 41452 

We have increased the Maximum Garbage Collection memory allocation to 100 GB from 1 GB 
in PRIMER 16.0. 

Sets 

• Case 40274 

A new SORT LATENT TO TOP button has been created for Sets of LIST type. Clicking it 
would bring all the latent entries to the top. 

Shortcut 

• Case 40832 

Added a shortcut for selecting centre node (around which model will rotate and zoom in and 
zoom out) using '.' key. If you press it again it will ask for selection of node again to user. 

User interface 

• Case 41760 

A custom tool button has been added to allow users to easily run their own scripts from the 
PRIMER tools menu. 

• Case 41266 

Errors and warnings in PRIMER are sent to the dialogue window, but because that is quite small, 
they can whizz out of sight quickly and may not be noticed. 

To solve this problem these messages are now trapped and stored in a special 'errors and 
warnings log', and a little red button at the top right of the dialogue box shows how many such 
messages have been added to the log since it was last inspected. This is very obvious, and acts as 
a visual warning that messages which need inspection have been written. 

Clicking on the button opens the log, allowing its contents to be inspected. The log is also stored 
in a file which is normally deleted when the PRIMER session ends, but this can be opened in a 
text editor and saved to a permanent file. 

Utilities 

• Case 41345 

Traditionally the drag and drop of files in PRIMER, D3PLOT and T/HIS was never recorded for 
the 'Checkpoint' files writing and for the Macro recording.  
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Now 'DragDropFiles' events are recorded in the Checkpoint files. 

For the macros recording/playback, a new MacroTag has been added: 

DragDropFile(<file_index_number>|<number_of_files>) = '<full_file_path>' ' 

This MacroTag will be written as many times as the number of files that are dropped into any of 
the program windows. 

X-sections 

• Case 42182 

An option has been added to the DATABASE_CROSS_SECTION edit panel to auto size the 
cross section plane to fit around the cut elements. 

ZTF 

• Case 41528 

PRIMER now allows users to select/deselect specific ZTF modules. Said user control is only 
being provided for certain modules. All others are written to the .ztf file unconditionally. 

• Case 40091 

PRIMER now allows users to select/deselect some of the ZTF modules that are written out. The 
categories that support user-selection include Composite, Load, Orthotropic, Spotweld and Set. 
Modules that do not fit into these categories will be written out unconditionally. 
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3.2  D3PLOT 

3.2.1  Enhancements in 17.0 

Command files 
• Case 42463 

Now, the Checkpoint files panel is disabled in D3PLOT by default. However, they can be 
activated via the preference 'show_checkpoint_files'.  

Also added a command line options '-checkpoint_dir' and '-show_checkpoint_files' to control 
Read/Write of Checkpoint files in D3PLOT. 

D3PLOT → PRIMER link 

• Case 40662 

D3PLOT can automatically locate an associated LS-DYNA keyword file to load in a linked 
PRIMER session. The logic used to locate the keyword deck has been improved in Oasys Suite 
17.0: 

1. The model name is now written to the ZTF file and is read by D3PLOT. If this model 
exists, it is auto-loaded in PRIMER. If the ZTF file is missing, the approach depends on 
filename convention: 

If you use the LSTC results filename convention (d3plot) 

2. D3PLOT looks to see if there is a single LS-DYNA keyword file (.key/.k/.kby or a .gz/.zip 
variant thereof) in the working directory and auto-loads it in PRIMER. 

If you use the Oasys results filename convention (.ptf) 

2. D3PLOT looks to see if a <job>.ptf has been loaded. If yes, D3PLOT looks for a matching 
<job>.key/.k/.kby or a .gz/.zip variant thereof. 

3. Failing that, D3PLOT looks to see if there is a single LS-DYNA keyword file in the 
working directory. 

The final fall-back, as always, is for you to manually select an input deck to load in PRIMER. 

Dialogue command 
• Case 42686 

For properties, contour colours, and graticules, users can set the colour to be any of the 14 new 
core colours added from T/HIS, or a user-defined colour from their session. 
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Graphics 

• Case 33833 

In D3PLOT 17.0, normal SHELL elements (ELEMENT_SHELL) can now be drawn with 
thickness. This option can be turned ON and OFF (the default is OFF) on a per-part basis via 
either the Quick Pick menu or by right clicking on a part in the PART TREE. 

Drawing shells with thickness is slower because each shell must be drawn at least twice for the 
top and bottom faces (if it is on a free edge then the edge also has to be drawn). It also requires 
more memory as we have to calculate and store additional ‘fake’ coordinates for each state for 
the top and bottom surfaces. 

The new ‘thickness’ option applies to LI, SH, HI, CT, SI and LC plots. Cloud and ISO plots are 
still drawn using the standard ‘thin’ shell logic.  

If a cut section cuts through a shell part being drawn with thickness, then at present the cut face 
is not contoured; it is drawn in grey. 

The thickness used for each element is taken from the PTF file and can vary from state to state if 
element thickness has been output to the PTF file. If they have not, then D3PLOT will use the 
ZTF file created by PRIMER and the thicknesses will remain constant from state to state. If 
elements have been defined using *ELEMENT_SHELL_THICKNESS, then the ZTF file should 
contain those values and they will be used. If they have not, then D3LOT will use the thickness 
defined via the *SECTION card. 

As well as using the thickness defined on the *SECTION card, D3PLOT will also use the NLOC 
option to correctly offset the thickness if the nodes have been positioned at the top or bottom 
surfaces. Currently, the per element NLOC option defined using *ELEMENT_SHELL_OFFSET 
is not supported. 

Image 

• Case 40708 

Default Image Format for all the Oasys Suite 17.0 products is now changed to PNG_24 from the 
previous default of JPG_24. 

Integration 

• Case 41390 

D3PLOT can now launch the Dyna output tree viewer in the integrated PRIMER session. PARTs 
and ELEMENTs sketched in PRIMER via this panel can also be sketched in the D3PLOT 
window. Additionally, the D3PLOT output Timestep can be changed via this panel in PRIMER. 

Manual 

• Case 40650 

A Visual Studio Code Intellisense file has been produced for the D3PLOT JavaScript API to aid 
writing scripts. It can be found in the OA_INSTALL/Intellisense directory along with 
instructions on how to use it. 
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Menus 

• Case 42009 

Some alternative search phrases have been added to Quickfind: 

- 'Write Video' for the Images → Write → Movies menu 

- 'Background Video' for the Images → Read → Background Movies menu 

- 'Full Screen' and 'Part Screen' for the Window Dressing menu 

• Case 42001 

There is a new colour popup into D3PLOT in commonly used menus (including quick pick, part 
tree, properties, contour colours, background colour, and graticules). Users now have a choice of 
30 core colours, increased from D3PLOT 16.0.  

Users have the ability to add up to 150 user-defined colours which can be saved for future use.  
The colour popup is akin to T/HIS with a similar selection of colours. Any saved user colours are 
the available in both D3PLOT and T/HIS. 

Additionally, the new core colours can be accessed in preferences and dialogue inputs. 

Preferences 
• Case 42633 

For contour colours, background and text colours, and graticules users can set the colour to be 
hex code, e.g. 0Xa1b2c3, or any of the 14 new core colours added from T/HIS. 

Scripting 

• Case 41452 

We have increased the Maximum Garbage Collection memory allocation to 100 GB from 1 GB 
in D3PLOT 16.0. 

Speed 

• Case 42423 

More operations in D3PLOT are now threaded, so they can run on several processors at the same 
time, which improves speed. This should not affect the results, but just in case of unexpected 
behaviour, this threading can be turned off on the new Threading tab on the Tune panel either for 
individual categories or altogether. The categories for the threading are: 

- Contour Scan (finding minimal/maximal values of data components for the contour bar) 

- Data Averaging at nodes (used as part of contour calculation when averaging is turned 
on) 

- Shell normal calculations (for graphics update when hardware shaders are turned off) 

- Shell thickness calculations (used to calculate surfaces when the new 'thickness' option 
for shells is turned on) 
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- Internal face calculations and Marking visible items (both used when blanking items or 
turning on/off display of entity types) 

The maximum number of threads can be controlled with the environment variable 
D3PLOT_NUM_THREADS_17. 

Utilities 

• Case 41345 

Traditionally the drag and drop of files in PRIMER, D3PLOT and T/HIS was never recorded for 
the 'Checkpoint' files writing and for the Macro recording.  

Now 'DragDropFiles' events are recorded in the Checkpoint files. 

For the macros recording/playback, a new MacroTag has been added: 

DragDropFile(<file_index_number>|<number_of_files>) = '<full_file_path>' ' 

This MacroTag will be written as many times as the number of files that are dropped into any of 
the program windows. 

Write 

• Case 41793 

If a user selected 10-node tetrahedral elements or 20-node hexahedral elements in Write → 
Keyword data and then selected nodal coordinate output, only nodes at the element vertices 
would be output. Now, mid-side nodes are also output. 

ZTF 

• Case 42192 

There are new command line options to suppress reading additional files: 

- -no_ztf to avoid additional data from a ZTF file 

- -no_prop to avoid a property file 

- -no_set to avoid a settings file 

- -no_group to avoid an ascii groups file 

- -no_ifs to avoid a file with interface force segments and data 

- -no_xtf to avoid springs, masses, joints etc. 

- -no_lsda to avoid spotweld, SPC etc. data 
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3.3 T/HIS 

3.3.1 Enhancements in 17.0 

Command files 
• Case 42464 

Now, the Checkpoint files panel is disabled in T/HIS by default. However, they can be activated 
via the preference 'show_checkpoint_files'.  

Also added a command line options '-checkpoint_dir' and '-show_checkpoint_files' to control 
Read/Write of Checkpoint files in T/HIS. 

Curves 

• Case 38830 

A 'Lock' button has been added to the top of each graph, which locks all the blanked curves in 
that graph to remain blanked. In particular, they will not be made visible with shortcut keys such 
as 'u' or 'r'. An additional option had been added to 'Freeze' curves, which is the equivalent to 
locking but for visible curves. This fixes curves as visible in the graphs they are 'frozen' in. This 
is accessed using the quick-pick menu or the curve manager. 

Locking and Freezing can also both be applied from the curve table. The graph buttons in the 
curve table, used for blanking/unblanking the curves, can be repurposed by selecting the 
'Locking/Freezing' option. Then, if a blanked curve is selected, the button goes red and the curve 
is locked, if a visible curve is selected, then the button goes green and the curve is frozen. The 
buttons at the top of each column lock all curves on the corresponding graph, in the same way as 
the 'Lock' button at the top of each graph. 

Datum 

• Case 40372 

Labels on datums can now be displayed vertically as well as horizontally. 

• Case 40087 

The limit of 1024 points in a datum has been removed. 

• Case 38526 

FAST-TCF variables can now be used in Datum definitions inside FAST-TCF scripts. 

• Case 38115 

There is now an option to add a second value to constant X, Y and Y2 datums, creating a second 
datum line within the same definition. The second line can have a corresponding label. There is 
also an additional fill option to fill in between the two datum lines. 
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FAST-TCF 

• Case 40371 

A 'read_diadem' command has been added to FAST-TCF to read DIAdem channels by name or 
comments rather than channel number. The following command reads all channels from file 
example.dat whose name or comments contain the string 'example_string', taking x-values from 
channel 1: 

read_diadem 'example.dat' 'example_string' xc 1 

Image 

• Case 40708 

Default Image Format for all the Oasys Suite 17.0 products is now changed to PNG_24 from the 
previous default of JPG_24. 

JavaScript API 

• Case 40081 

Added Curve.GetFlagged(f) to the Curve class in the T/HIS JavaScript API. This takes a flag as 
an argument and returns all the curves that have this flag set as an array of curve objects. 

• Case 39627 

The 'Options.auto_confirm' property is now usable in the T/HIS JavaScript API. If this is set to 
true, then most information popups that prompt the user for confirmation will be confirmed 
automatically. 

• Case 39013 

Added Group.DeleteGroup function to the Group class in JavaScript. This allows one or all 
curve groups to be deleted, either by name or index. Also fixed some issues with generation and 
deletion of automatic curve groups. Additionally, if a model is deleted and the corresponding 
automatically generated curve group is empty, it will now be deleted. 

• Case 38952 

It can now be determined whether a graph is active from inside a JavaScript using the g.active 
property. 

New Feature 

• Case 42334 

There is now an 'Equation' option in the Read panel in T/HIS, allowing creation of curves by 
entering an equation of the form 'y = f(x)'. There are several options to define the x-values used 
to create the curve. Additionally, curves can be referenced as variables in the equation, e.g. 
'#1','c1' or 'C1' would refer to curve #1, allowing multiple curve operations to be replaced by a 
single equation. 



Oasys Ltd LS-DYNA Environment Software Release Notes 

Version 17.0 
 

Ove Arup and Partners Limited | Final | March 2020  

 

Page 69 
 

Scripting 

• Case 41452 

We have increased the Maximum Garbage Collection memory allocation to 100 GB from 1 GB 
in T/HIS 16.0. 

T/HIS → PRIMER link 

• Case 40663 

T/HIS can automatically locate an associated LS-DYNA keyword file to load in a linked 
PRIMER session. The logic used to locate the keyword deck has been improved in Oasys Suite 
17.0: 

4. The model name is now written to the ZTF file and is read by T/HIS. If this model exists, it 
is auto-loaded in PRIMER. If the ZTF file is missing, the approach depends on filename 
convention: 

If you use the LSTC results filename convention (d3thdt, xtfile) 

5. T/HIS looks to see if there is a single LS-DYNA keyword file (.key/.k/.kby or a .gz/.zip 
variant thereof) in the working directory and auto-loads it in PRIMER. 

If you use the Oasys results filename convention (.thf, .xtf) 

2. T/HIS looks to see if a <job>.thf has been loaded. If yes, T/HIS looks for a matching 
<job>.key/.k/.kby or a .gz/.zip variant thereof. 

3. If a <job>.thf is not found, T/HIS tries a similar logic with a potential <job>.xtf file. 

4. Failing all of that, T/HIS looks to see if there is a single LS-DYNA keyword file in the 
working directory. 

The final fall-back, as always, is for you to manually select an input deck to load in PRIMER.  

User defined 

• Case 41999 

There are now 150 slots for user-defined colours, instead of only 6 previously. Colours can now 
be created from inside the colour popup using the colour palette. Once created, the colours can 
be saved to a file, user_colours.xml, which is then read every time T/HIS starts.  

The location of this file can be set using the preference 'user_colours_file' but will be in the 
user’s home directory by default. This file is also read by D3PLOT, so the same colours will be 
available in both programs.  

Additionally, all RGB colours are now supported in JavaScript, using the Colour.RGB function, 
and FAST-TCF, using HEX codes in place of colour names. 
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Utilities 

• Case 41345 

Traditionally the drag and drop of files in PRIMER, D3PLOT and T/HIS was never recorded for 
the 'Checkpoint' files writing and for the Macro recording.  

Now 'DragDropFiles' events are recorded in the Checkpoint files. 

For the macros recording/playback, a new MacroTag has been added: 

DragDropFile(<file_index_number>|<number_of_files>) = '<full_file_path>' ' 

This MacroTag will be written as many times as the number of files that are dropped into any of 
the program windows. 
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3.4 REPORTER 

3.4.1 Enhancements in 17.0 

Generate 
• Case 17290 

A 'Generate' toolbar has been added to the top of the main window as another way of generating 
templates, pages and selected items. 

Image 
• Case 41674 

Image size can now be controlled for 'Blank' PRIMER, D3PLOT and T/HIS items (so that any 
images created via scripts or command files can have image size control). 

• Case 40708 

Default Image Format for all the Oasys Suite 17.0 products is now changed to PNG_24 from the 
previous default of JPG_24. 

Integration 

• Case 40886 

REPORTER can now be linked to both D3PLOT and T/HIS, or the D3PLOT → T/HIS link, by 
opening one program from another. This allows reports to be created and edited interactively. 
Windows and graphs can be captured into REPORTER easily and reloaded back from 
REPORTER, all in the same session. When generating reports, D3PLOT and T/HIS items will 
be generated in the same session of their respective programs without loading the same model 
more than once. 

This is mostly controlled from the new REPORTER panel which will open when the 
REPORTER button in the top-right of T/HIS or D3PLOT is pressed. In this panel, there will be 
an item tree displaying all the items currently present in REPORTER, as well as a list of the 
current graphs in T/HIS. Using this panel, windows, graphs and REPORTER items can be 
selected for capturing and reloading. Additionally, there are buttons at the top of each window 
and graph to allow them to be captured, resized to fit a REPORTER item or have an item 
reloaded into them. 

Additionally, the REPORTER panel can be expanded to display the variables panel, which 
allows variables to be added to items easily before capturing them. The variables panel now has 
an improved user-interface and more intuitive behaviour than the existing variables panel. 

Further details of this can be found in the new features PowerPoint and the users' manual. 
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JavaScript API 

• Case 41602 

In the JavaScript API Image class, it is now possible to set an alternative background colour 
(including 'none') via a new third argument in the Image constructor. Also, previously, setting 
lineColour to 'none' had no effect, and setting lineWidth equal to zero resulted in a line width of 
1. Now fixed so that either setting will result in no line being drawn. 

Licensing 

• Case 42196 

The Logfile now displays more licensing information when REPORTER starts. 

Preferences 
• Case 42116 

It is now possible to save preferences directly from REPORTER via the 'Save preferences' button 
on the preferences dialog (accessed from File → Preferences). Various new preferences have 
been added to improve customisation of REPORTER. The Template Generation preferences 
have been moved to the new Template → Properties menu. 

• Case 13490 

A range of standard template layouts is now provided with REPORTER to provide creative 
inspiration, and to help you quickly create reports for a variety of applications. 

Scripting 

• Case 41022 

Images drawn using the JavaScript API Image class are now drawn with antialiasing to improve 
image quality. 

Standard Templates 

• Case 38165 

There are new pedestrian head impact templates for the Euro NCAP and GTR assessment 
protocols. They link with the HIC Area Calculator in PRIMER to show band and area sensitivity 
results. 

• Case 26278 

There are now pedestrian leg impact library templates for Euro NCAP, JNCAP and KNCAP 
protocols. 
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Tables 

• Case 40106 

It is now possible to set the line width and line colour of Autotable items. It is now also possible 
to set the fill and text colour for all cells/columns in Table/Autotable items via the Style toolbar. 

User interface 

• Case 42683 

A splash screen showing new features is now displayed when REPORTER opens. 

• Case 42659 

It is now possible to select all items on the current page with the shortcut Ctrl+A and to deselect 
all items in the current template with the shortcut Ctrl+Shift+A or the Esc key. 

• Case 42466 

A 'Page' toolbar has been added to the top of the main window to improve access to page 
creation, deletion, duplication, and page navigation controls. 

• Case 42457 

It is now possible to deselect individual items using Ctrl+Click or Shift+Click when the user has 
multiple items selected. 

• Case 41651 

The page orientation now automatically changes to landscape when you select a PowerPoint 
page size in File → Page setup. 

• Case 41604 

Improved access to the page master view: a page master view toggle button (shortcut key 'm') 
has been added to the View toolbar, and corresponding toggles have been added to the View and 
Page menus. The old Master dock widget has been removed. 

• Case 41603 

The Tools have been grouped into categories, and it is now possible to switch on labels for the 
tool buttons. 

• Case 40700 

Newly-created items now remain selected, so that they can more conveniently be moved, resized 
or deleted. Keyboard shortcuts have been added for the Select tool ('s') and the Hand tool ('h'). 

• Case 37479 

New GUI themes (Light and Dark) have been added to give REPORTER a modernised look and 
feel. The Legacy theme will continue to be supported for now, but support may be removed in 
future versions. 
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• Case 37477 

REPORTER's user interface has been upgraded, with new Light and Dark themes, new icon and 
cursor designs, and improved toolbars. 

• Case 35877 

The cursors for the different Tools have been updated to make it clearer when you need to drag a 
box, or just click somewhere on the page. 

• Case 7764 

The attributes (geometry, style, font, paragraph, alignment) of all selected items can now be 
controlled via new toolbars in the main window. 

Variables 

• Case 42117 

Formatting control for the DATE variable has been added using %DATE(format)%. 

Write 
• Case 42030 

You can now File → Save As... Template, Report, PDF, PowerPoint and HTML. You can still 
write PDF, PowerPoint and HTML from File → Write PDF etc. 
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3.5 SHELL 

3.5.1 Enhancements in 17.0 

Encryption 
• Case 39196 

Added 'PGPKey' option while submitting LS-DYNA jobs via the SHELL. 

Integration 

• Case 40583 

Added options in the SHELL panels to control the Read/Write of the Checkpoint files while 
launching programs like PRIMER, T/HIS or D3PLOT via the SHELL 

Manual 

• Case 37597 

Added a link to the LS-DYNA manuals available in the installation directory via the 'Manuals' 
popup menu panel. 

PowerPoint 

• Case 42677 

Changed the option to write out the REPORTER outputs in Microsoft PowerPoint format as 
default output format. 

Sensor 

• Case 38756 

Added the various new SENSOR Switch controls that are defined in the LS-DYNA manuals into 
the SHELL. 

User interface 

• Case 42875 

Added an Option in the LS-DYNA submission panel to choose a local executable for submission 
of analyses. 

• Case 39697 

Now the Command Line SHELL will show the SHELL Version and Revision numbers. 

 


